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Safety information

VAN

Always follow basic safety precautions
when using this product to reduce risk of
injury from fire or electric shock.

1. Read and understand all instructions in
the documentation that comes with the
printer.

2. Observe all warnings and instructions
marked on the product.

3. Unplug this product from wall outlets
before cleaning.

4. Do not install or use this product near
water, or when you are wet.

5. Install the product securely on a stable
surface.

6. Install the product in a protected location
where no one can step on or trip over the
line cord, and the line cord cannot be
damaged.

7. If the product does not operate normally,
see Solve a problem.

8. There are no user-serviceable parts
inside. Refer servicing to qualified service
personnel.
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How do |?

o  Get started
° Print
° Use HP ePrint

e  Work with ink cartridges

° Solve a problem




2 Get started

This guide provides details about how to use the printer and how to resolve problems.

e Accessibility
° HP EcoSolutions (HP and the Environment)

° Understand the printer parts

° Use the printer control panel

° Paper basics

° Load paper
e Update the printer

e Open the HP printer software (Windows)

e  Turn the printer off

Accessibility

The printer provides a number of features that make it accessible for people with disabilities.
Visual

The HP software provided with the printer is accessible for users with visual impairments or low vision
by using your operating system's accessibility options and features. The software also supports most
assistive technology such as screen readers, Braille readers, and voice-to-text applications. For users
who are color blind, colored buttons and tabs used in the HP software have simple text or icon labels
that convey the appropriate action.

Mobility

For users with mobility impairments, the HP software functions can be executed through keyboard
commands. The HP software also supports Windows accessibility options such as StickyKeys,
ToggleKeys, FilterKeys, and MouseKeys. The printer doors, buttons, paper trays, and paper-width
guides can be operated by users with limited strength and reach.

Support

For more details about the accessibility of this printer and HP's commitment to product accessibility,
visit HP's website at www.hp.com/accessibility.

For accessibility information for Mac OS X, visit the Apple website at www.apple.com/accessibility.

HP EcoSolutions (HP and the Environment)

Hewlett-Packard is committed to helping you optimize your environmental footprint and empowering
you to print responsibly—at home or in the office.

For more detailed information about environmental guidelines that HP follows during the
manufacturing process, see Environmental product stewardship program. For more information about
HP's environmental initiatives, visit www.hp.com/ecosolutions.
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° Manage Power
e  Optimize Printing Supplies

Manage Power

To conserve electricity, the printer comes with the following features:

Sleep mode

Power usage is reduced while in Sleep mode. The printer goes into low-power mode after 5 minutes
of inactivity.

To change the time to Sleep mode:

1. Open the embedded web server (EWS). For more information, see Open the embedded web
server.

2. Click the Settings tab.

In the Power Management section, click Energy Save Mode and select the desired option.

Click Apply.

Auto-Off

Auto-Off is automatically enabled by default when you turn on the printer. When Auto-Off is enabled,
the printer will automatically turn off after 8 hours of inactivity to help reduce energy use. Auto-Off
turns the printer off completely, so you must use the Power button to turn the printer back on. For
printer models with wireless or Ethernet network capability, Auto-Off is automatically disabled when
the printer establishes a wireless or Ethernet network connection. Even when Auto-Off is disabled,
the printer enters Sleep mode after 5 minutes of inactivity to help reduce energy use.

1. Open the embedded web server (EWS). For more information, see Open the embedded web
server.

2. Click the Settings tab.

3. Inthe Power Management section, click Auto Off and select the desired option.
4. Click Apply.
/\ CAUTION: Always turn the printer off properly, using either Auto-Off or (I} (the Power button).

If you improperly turn the printer off, the print carriage might not return to the correct position, causing
problems with the ink cartridges and print quality issues.

E’)?NOTE: The printer's Sleep Mode and Auto-Off features are temporarily not available if one or more
of the ink cartridges are missing. After the cartridge is reinstalled, these features resume.

Optimize Printing Supplies
To optimize printing supplies such as ink and paper, try the following:

e  Recycle used original HP ink cartridges through HP Planet Partners. For more information, visit
www.hp.com/recycle.

e  Optimize paper usage by printing on both sides of the paper.

e  Save ink and paper when printing web content with HP Smart Print. For more information, visit
www.hp.com/go/smartprint.

ENWW HP EcoSolutions (HP and the Environment) 3
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e Change the print quality in the printer driver to a draft setting. The draft setting uses less ink.

e Do not clean the printhead unnecessarily. Doing so wastes ink and shortens the life of the

cartridges.

Understand the printer parts

This section contains the following topics:
e  Front view

° Printing supplies area

° Back view

Front view

)

1 Ink cartridge access door
2 Control panel

3 Output tray extender

4 Paper-width guides

5 Input tray

6 Output tray

7 Power button

Chapter 2 Get started
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Printing supplies area

1 Printhead

2 Ink cartridges

E’%NOTE: Ink cartridges should be kept in the printer to prevent possible print quality issues or

printhead damage. Avoid removing supplies for extended periods of time. Do not turn the printer off

when a cartridge is missing.

Back view

1 Universal serial bus (USB) port

2 Ethernet network port

3 Power input

Use the printer control panel

This section contains the following topics:

e Overview of buttons and lights

e Control panel lights reference

ENWW

Use the printer control panel
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Overview of buttons and lights

The following diagram and related table provides a quick reference to the printer control panel
features.

Name and Description

Power button

Turns the printer on or off. It is dimmed when the printer is in sleep mode.

Paper Size Selection button and lights
Use the |_-|!|:\I (Paper Size Selection) button to select the paper size you have loaded in the input tray.

Each time you press the button, the light will move downwards to the next light, selecting the paper size corresponding
with the light. At the bottom light, pressing the button selects the top light and its corresponding paper size.

Ink cartridge lights

Provide information about the printhead and ink cartridges, such as the status of estimated ink levels and problems with
the cartridges or printhead.

HP ePrint button and light

Turns HP ePrint on or off, and indicates the connection to Web Services, including HP ePrint.

Wireless button and light

Turns the wireless feature on or off and indicates the status of the printer's wireless connection.

ress the Ireless) button an e nrormation ution togetner to prin € network contiguration page an
Press the ((#)) (Wireless) butt dth Information) button together to print the network configurati d

the wireless network test report.

HP wireless direct button and light

Turns HP wireless direct on or off.

Information button

Prints an information page focused on connectivity and Web Services, information, and help. This button can also be
used along with other buttons to print more detailed information about specific functions in the printer.

Resume button and light

Resumes a job after a disruption (for example, after loading paper or clearing a paper jam).

Cancel button

Cancels a print job or mainentance procedure that is in progress.

For more information about the the lights' patterns and status, see Control panel lights reference.

Control panel lights reference

The control panel lights indicate status and are useful for diagnosing printing problems. This section
contains information about the lights, what they indicate, and what action to take if necessary.

Chapter 2 Get started ENWW



The HP printer software also provides information about the printer's status and possible printing
problems.

For more information, visit the HP website www.hp.com/support for the latest troubleshooting
information, product fixes, and updates. This website provides information and utilities that can help
you correct many common printer problems.

The Power button
e The following table provides information on the button's different light patterns.

Table 2-1 Power button

Light description/Light pattern

Explanation and recommended action

All lights are off.

The printer is off.

e  Connect the power cable.

* Press the (1) (Power) button.

The Power light is on.

The printer is ready. No action is required.

The Power light blinks.

The printer is turning on or off, or is processing a print job.

e No action is required.
The printer is pausing for the ink to dry.

e  Wait for the ink to dry.

ENWW Use the printer control panel
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The Power button and Resume button.
e The following table provides information on the buttons' different light patterns.

Table 2-2 Power button and Resume button

Light description/Light pattern

Explanation and recommended action

The Power light and the Resume light blink.

One of the following problems might have occurred.
1. Print media is jammed in the printer.

e Locate and clear the jam. For more information, see Clear paper jams.
Press the E (Resume) button to continue printing.

2. The printer carriage has stalled.

e  Open the ink cartridge access door and remove any obstructions (such as jammed
paper).

Press the B (Resume) button to continue printing.
. If the error persists, turn the printer off, and then on again.

To cancel the print job, press the x (Cancel) button.

The Power light is on and the Resume light blinks.

One of the following problems might have occurred.

1. The printer is out of paper.
Load paper and press the B (Resume) button to continue printing.

2. There is a paper mismatch.

This occurs when paper loaded in the input tray does not match the paper size setting on the
printer control panel, and in the printer driver or on your mobile device.

Do one of these:

e  Change the paper.

Chapter 2 Get started
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Table 2-2 Power button and Resume button (continued)

Light description/Light pattern

Explanation and recommended action

a. Load paper that matches the paper size setting on the printer control panel, and in the
printer driver or on your mobile device.

Press the @ (Resume) button to continue printing.
e  Change the paper size setting if you have loaded the desired paper.
Press the x (Cancel) button to cancel printing.

b.  Ensure the paper size setting on the printer control panel, and in the printer driver or on
your mobile device matches the paper loaded. For information on changing paper size,
see Set the paper size for the printer.

c.  Print your document again.

The Power light and the Resume light are on.

A door or cover is not closed completely.

e  Make sure all doors and covers are completely closed.

To cancel the print job, press the x (Cancel) button.

The Power button and ink cartridge lights
e The following table provides information on the buttons' different light patterns.

Table 2-3 Power button and ink cartridge lights

Light description/Light pattern

Explanation and recommended action

The Power light is on and the ink cartridge lights blink one after the other, from left to right.

ENWW Use the printer control panel 9



Table 2-3 Power button and ink cartridge lights (continued)

Light description/Light pattern

Explanation and recommended action

The printhead is missing or faulty.
e  Turn off the printer, and then turn it on again.

. If the error persists, contact HP support for service or replacement.

The Power light is on and one or more of the ink cartridge lights blink.

One or more of the ink cartridges need attention or are faulty, incorrect, missing, damaged, or
incompatible.

e  Ensure the indicated ink cartridge is properly installed, and then try to print. Remove and re-
insert the ink cartridge a few times if necessary.

e If the error persists, replace the indicated ink cartridge.

For more information, you can also refer to the help message in the HP printer software.

The Power light and one or more of the ink cartridge lights are on.
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Table 2-3 Power button and ink cartridge lights (continued)

Light description/Light pattern

Explanation and recommended action

One or more of the ink cartridges are low on ink.

NOTE: Ink level alerts and indicators provide estimates for planning purposes only. When you
receive a low-ink warning message, consider having a replacement cartridge available to avoid
possible printing delays. You do not need to replace the cartridges until print quality becomes
unacceptable.

The Power light is on, one or more of the ink cartridge lights are on, and the Resume light blinks.

One of the following might occur. Refer to the help message in the HP printer software for more
information.

1. One or more of the ink cartridges are very low on ink.
Press the B (Resume) button to continue using the existing cartridges.

NOTE: Ink level alerts and indicators provide estimates for planning purposes only. When
you receive a low-ink warning message, consider having a replacement cartridge available to
avoid possible printing delays. You do not need to replace the cartridges until print quality
becomes unacceptable.

2. One or more of the ink cartridges are counterfeit or not new.

NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Product service or
repairs required as a result of using a non-HP supply will not be covered under warranty.

If you believe you purchased Original HP ink cartridges, go to www.hp.com/go/anticounterfeit.

3. A supply secure upgrade is detected.

Press the @ (Resume) button to upgrade the printer supply. If the Resume light turns off and

one or more of the ink cartridge lights blink after the upgrade, the upgrade was not successful.

The Power light, the Resume light, and all of the ink cartridge lights blink.

A non-recoverable error has occurred. Unplug the power cord, and then plug the power cord back
in, and try printing.

ENWW Use the printer control panel

11


http://www.hp.com/go/anticounterfeit

The HP ePrint button

e The following table provides information on the button's different light patterns.

Table 2-4 HP ePrint button

Light description/Light pattern

Explanation and recommended action

The HP ePrint light is off.

One of the following problems might have occurred.

1. HP ePrint has not been set up.

To set up HP ePrint, press the E?-I (HP ePrint) button, and then follow the instructions on the

information page that prints.

2. HP ePrint has been set up but has been turned off.
To turn on HP ePrint, press the E?-l (HP ePrint) button.

HP ePrint might have been disabled in the EWS.
3. HP ePrint has been set up but has been turned off because the printer has not been updated.

If a mandatory update for the printer is available but has not been installed, HP ePrint is turned
off.

To update the printer, press the EE (HP ePrint) button and the @ (Information) button

together, and then follow the instructions on the page that prints.

4. HP ePrint has been disabled by the IT administrator.

For more information, press the X HP ePrint) button and the Information) button
J

together, and then follow the instructions on the page that prints; or contact the IT
administrator or the person who set up the printer.

The HP ePrint light is on.

If you press the E?-I (HP ePrint) button and the ® (Information) button together, the printer prints

an information page that includes the email address you will use for printing documents using HP
ePrint.
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Table 2-4 HP ePrint button (continued)

Light description/Light pattern

Explanation and recommended action

To turn off HP ePrint, press the X (HP ePrint) button. The HP ePrint light turns off.
3

The HP ePrint light blinks.

HP ePrint is turned on, but the printer is not connected to the Web Services server. The light also
blinks while checking the status of the connection.

For more information, press the Esi_"-l (HP ePrint) button and the ® (Information) button together,

and then follow the instructions on the page that prints.

The Wireless button
e  The following table provides information on the button's different light patterns.

Table 2-5 Wireless button

Light description/Light pattern

Explanation and recommended action

The Wireless light is off.

The wireless capability of the printer is turned off.

NOTE: Make sure that an Ethernet cable is not connected to the printer. Connecting an Ethernet
cable turns off the printer wireless capability.

The Wireless light is on but blinking.

ENWW Use the printer control panel
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Table 2-5 Wireless button (continued)

Light description/Light pattern

Explanation and recommended action

The wireless capability of the printer is turned on, and the printer is either not connected to a
network or trying to connect to a network.

The Wireless light is on and solid.

The wireless capability of the printer is turned on and the printer is connected to a network.

If the printer is connected to a network, you can print a network configuration page to view the
network settings for the printer and a list of networks detected by your printer.

Press the ({ ' :l) (Wireless) button and the ® (Information) button together to print the network

configuration page and the wireless network test report.

The HP wireless direct button
e The following table provides information on the button's different light patterns.

Table 2-6 HP wireless direct button

Light description/Light pattern

Explanation and recommended action

The HP wireless direct light is off.

The HP wireless direct capability of the printer is turned off.

The HP wireless direct light is on but blinking.

The HP wireless direct capability of the printer is turning on or off.

The HP wireless direct light is on and solid.
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Table 2-6 HP wireless direct button (continued)

Light description/Light pattern

Explanation and recommended action

The HP wireless direct capability of the printer is turned on.

If you press the @ (HP wireless direct) button and the @ (Information) button together, the

printer prints the HP Wireless Direct Guide. The guide provides step-by-step instructions to use HP
wireless direct. It includes the HP wireless direct network name and password along with
instructions on how to connect mobile devices, how to print the page again, and how to customize
the HP wireless direct settings.

The Paper Size Selection button and lights
e  The following table provides information on the button's different |

Table 2-7 Paper Size Selection button and lights

ight patterns.

Light description/Light pattern

Explanation and recommended action

One of the Paper Size Selection lights is on.

The paper size selection light that is lit indicates the current paper size setting selected.

If you have loaded a different paper size, set the paper size on the printer to match (see Set the
paper size for the printer).

For better printing experience, be sure to load paper that matches the paper settings of the printer.

One of the Paper Size Selection lights is blinking.

This occurs when you pull out the input tray. The Paper Size Selection light that is blinking indicates
the paper size currently set for the printer.

e If you have loaded a different standard paper size, choose the appropriate paper size by
pressing the button until the light matches the loaded paper size.

e  Once you are done checking paper or loading the correct paper, close the tray properly. The
light will stop blinking and become solid. If you have loaded a different paper size, set the
paper size in the printer to match (see Set the paper size for the printer).
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Table 2-7 Paper Size Selection button and lights (continued)

Light description/Light pattern

Explanation and recommended action

e If you press the button once when the light is blinking, blinking will also stop and the light will
become solid.

For more information, see the earlier case when one of the Paper Size Selection lights is on.

All Paper Size Selection lights are off.

This occurs when you select a paper size from a software application or embedded web server
(EWS) that is not one of the sizes on the printer control panel.

Be sure to load paper that matches the paper settings you have selected, and then close the input
tray properly.

All Paper Size Selection lights are blinking.

This occurs when you pull out the input tray after selecting a paper size from a software application
or EWS that is not one of the sizes on the printer control panel.

The lights stop blinking when you close the tray or press the selection button once.

If you are loading paper of a size that is available on the control panel, use the selection button to
select the size of the paper loaded (see Set the paper size for the printer). Otherwise, load paper
that matches the paper settings you have selected, and then close the input tray properly.

The Paper Size Selection lights are cycling or blinking in sequence one after another from top to
bottom (for about 10 seconds).

NOTE: This section is only applicable to newer versions of iOS and OS X devices.

When you connect your Apple mobile device to your printer, the paper size selection lights blink in
sequence for about 10 seconds, and then stop. The blinking lights confirm that your mobile device
is connected to the correct printer.

If you press the selection button once, the lights will stop blinking.

Paper basics

The printer is designed to work well with most types of office paper. It is best to test a variety of print
paper types before buying large quantities. Use HP paper for optimum print quality. Visit the HP
website at www.hp.com for more information about HP paper.
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HP recommends plain papers with the ColorLok logo for printing everyday
documents. All papers with the ColorLok logo are independently tested to meet high
standards of reliability and print quality, and produce documents with crisp, vivid
color, bolder blacks, and that dry faster than ordinary plain papers. Look for papers
with the ColorLok logo in a variety of weights and sizes from major paper
manufacturers.

This section contains the following topics:

Recommended papers for printing

Order HP paper supplies

Tips for selecting and using paper

Recommended papers for printing

Photo printing

ENWW

If you want the best print quality, HP recommends using HP papers that are specifically designed for
the type of project you are printing.

Depending on your country/region, some of these papers might not be available.

HP Premium Plus Photo Paper

HP Premium Plus Photo Paper is HP’s highest-quality photo paper for your best photos. With
HP Premium Plus Photo Paper, you can print beautiful photos that are instant-dry so you can
share them right off the printer. It is available in several sizes, including A4, 8.5 x 11 inches, 4 x
6 inches (10 x 15 cm), 5 x 7 inches (13 x 18 cm), and 11 x 17 inches (A3), and in two finishes -
glossy or soft gloss (semi-gloss). Ideal for framing, displaying, or gifting your best photos and
special photo projects. HP Premium Plus Photo Paper delivers exceptional results with
professional quality and durability.

HP Advanced Photo Paper

This thick photo paper features an instant-dry finish for easy handling without smudging. It
resists water, smears, fingerprints, and humidity. Your prints have a look and feel comparable to
a store-processed photo. It is available in several sizes, including A4, 8.5 x 11 inches, 10 x

15 cm (4 x 6 inches), 13 x 18 cm (5 x 7 inches), and two finishes — glossy or soft-gloss (satin
matte). It is acid-free for longer lasting documents.

HP Everyday Photo Paper

Print colorful, everyday snapshots at a low cost, using paper designed for casual photo printing.
This affordable photo paper dries quickly for easy handling. Get sharp, crisp images when you
use this paper with any inkjet printer. It is available in glossy finish in several sizes, including A4,
8.5 x 11 inches, and 10 x 15 cm (4 x 6 inches). It is acid-free for longer lasting documents.

HP Photo Value Packs

HP Photo Value Packs conveniently package original HP ink cartridges and HP Advanced Photo
Paper to save you time and take the guesswork out of printing affordable, lab-quality photos with
your HP printer. Original HP inks and HP Advanced Photo Paper have been designed to work
together so your photos are long lasting and vivid, print after print. Great for printing out an entire
vacation's worth of photos or multiple prints to share.

Paper basics
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Business documents
e HP Premium Presentation Paper 120g Matte

This paper is a heavy two-sided matte paper perfect for presentation, proposals, reports, and
newsletters. It is heavyweight for an impressive look and feel.

e  HP Brochure Paper 180g Glossy or HP Professional Paper 180 Glossy

These papers are glossy-coated on both sides for two-sided use. They are the perfect choice for
near-photographic reproductions and business graphics for report covers, special presentations,
brochures, mailers, and calendars.

e  HP Brochure Paper 180g Matte or HP Professional Paper 180 Matt

These papers are matte-coated on both sides for two-sided use. They are the perfect choice for
near-photographic reproductions and business graphics for report covers, special presentations,
brochures, mailers, and calendars.

Everyday printing

All the papers listed for everyday printing feature ColorLok Technology for less smearing, bolder
blacks, and vivid colors.

e  HP Bright White Inkjet Paper

HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque enough
for two-sided color usage with no show-through, which makes it ideal for newsletters, reports,
and flyers.

e  HP Printing Paper

HP Printing Paper is a high-quality multifunction paper. It produces documents that look and feel
more substantial than documents printed on standard multipurpose or copy paper. It is acid-free
for longer lasting documents.

e HP Office Paper

HP Office Paper is a high-quality multifunction paper. It is suitable for copies, drafts, memos, and
other everyday documents. It is acid-free for longer lasting documents.

e HP Office Recycled Paper
HP Office Recycled Paper is a high-quality multifunction paper made with 30% recycled fiber.

Order HP paper supplies

The printer is designed to work well with most types of office paper. Use HP paper for optimum print
quality.

To order HP papers and other supplies, go to www.hp.com. At this time, some portions of the HP
website are available in English only.

HP recommends plain papers with the ColorLok logo for printing and copying of everyday documents.
All papers with the ColorLok logo are independently tested to meet high standards of reliability and
print quality, and produce documents with crisp, vivid color, bolder blacks and dry faster than ordinary
plain papers. Look for papers with the ColorLok logo in a variety of weights and sizes from major
paper manufacturers.

Tips for selecting and using paper

For the best results, observe the following guidelines.
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e Load only one type of paper at a time into a tray.
e  When loading the tray, make sure the paper is loaded correctly.
e Do not overload the tray.

e To prevent jams, poor print quality, and other printing problems, avoid loading the following
paper in the tray:

° Multipart forms

° Media that is damaged, curled, or wrinkled

° Media with cutouts or perforations

° Media that is heavily textured, embossed, or does not accept ink well
° Media that is too lightweight or stretches easily

° Media that contains staples or clips

For more information on loading paper, see Load paper.

Load paper

To load standard paper

1.  Lift the output tray.

2. Pull out the input tray to extend it.

@NOTE: To load legal-size paper, slide the grey latch (on the front left of the input tray ) to the
right, and lower the front of the tray.
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3.  When you pull out the input tray, one or all the Paper Size Selection lights will blink (see Control
panel lights reference for printer lights behaviors).

If you are loading a different sized paper, change the paper size for the printer, see Set the
paper size for the printer.

4. Slide the paper-width guides out as far as possible.

Insert the paper print-side down in the center of the tray.
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Ensure that the stack of paper is aligned with the appropriate paper size lines on the bottom of
the input tray, and does not exceed the stack height marking on the side of the tray.

r__*:"/?NOTE: Do not load paper while the printer is printing.

6. Slide the paper-width guides in the tray until they touch the edge of the stack of paper, and then
close the tray.
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7. Pull out the output tray extension.

To load an envelope

1.  Lift the output tray.

2. Pull out the input tray to extend it.

3.  When you pull out the input tray, one or all the Paper Size Selection lights will blink (see Control
panel lights reference for printer lights behaviors).

E/?’NOTE: Envelope sizes likely do not match one of the paper sizes listed on the control panel,
and should be set in the EWS. For more information, see Set the paper size for the printer or
Embedded web server.
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4. Insert the envelopes print-side down and according to the graphic.

T+ f

Make sure the stack of envelopes does not exceed the line marking in the tray.

E%?NOTE: Do not load envelopes while the printer is printing.

5. Slide the paper-width guides in the tray until they touch the edge of the stack of envelopes, and
then close the tray.
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6. Pull out the output tray extension.

To load cards and photo paper

1.  Lift the output tray.

2. Pull out the input tray to extend it.

3.  When you pull out the input tray, one or all the Paper Size Selection lights will blink (see Control
panel lights reference for printer lights behaviors).

If you are loading a different sized paper, change the paper size for the printer, see Set the
paper size for the printer.
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4. Insert the paper print-side down in the center of the tray.

Ensure that the stack of paper is aligned with the appropriate paper size lines on the bottom of
the input tray, and does not exceed the stack height marking on the side of the tray.

E’%NOTE: Do not load paper while the printer is printing.

5. Slide the paper-width guides in the tray until they touch the edge of the stack of paper, and then
close the tray.

6. Pull out the output tray extension.
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Update the printer

HP is always working to improve the performance of its printers and bring you the latest features.

By default, if the printer is connected to a network and HP Web Services has been enabled, the
printer automatically checks for updates.

To update the printer using the embedded web server

1.  Open the embedded web server (EWS). For more information, see Open the embedded web
server.

2. Click the Tools tab.

3. Under Printer Updates, click Firmware Updates, and then follow the on-screen instructions.

E‘/?"NOTE: If a printer update is available, the printer downloads and installs the update, and then
restarts.

= NOTE: If prompted for proxy settings and if your network uses proxy settings, follow the on-screen
instructions to set up a proxy server. If you do not have the details, contact your network administrator
or the person who set up the network.

Open the HP printer software (Windows)

After installing the HP printer software, depending on your operating system, do one of the following:

e Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the
printer name.

e Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and
then select the printer name.

e Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All
Programs, click HP, click the folder for the printer, and then select the icon with the printer's
name.

Turn the printer off

Turn the printer off by pressing the (3 (Power) button located on the front left side of the printer. The

power light flashes while the printer shuts down. Wait until the power light turns off before unplugging
the power cord or turning off a power strip.

: If you improperly turn the printer off, the print carriage might not return to the correc
CAUTION: If i ly turn the printer off, the print [ ight not return to th t
position, causing problems with the ink cartridges and print quality.

CAUTION: Never turn off the printer when ink cartridges are missing. HP recommends that you
replace any missing cartridges as soon as possible to avoid print quality issues, possible extra ink
usage from the remaining ink cartridges, or damage to the ink system.
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3 Print

Most print settings are automatically handled by the software application. Change the settings
manually only when you want to change print quality, print on specific types of paper, or use special
features.

For more information about selecting the best print paper for your documents, see Paper basics.

3@'— TIP: This printer includes HP ePrint, a free service from HP that allows you to print documents on
*" your HP ePrint-enabled printer anytime, from any location, without any additional software or printer
drivers. For more information, see Use HP ePrint.

TIP: You can use this printer to print documents and photos on your mobile device (such as a
smartphone or tablet). For more information, visit the HP Mobile Printing website (www.hp.com/go/
mobileprinting). (At this time, this website might not be available in all languages.)

Print documents

Print brochures

Print on envelopes

Print photos

Print on special and custom-size paper

Print on both sides (duplexing)

Print using the maximum dpi

Tips for print success

Print with AirPrintTM

Set the paper size for the printer

Print documents

To print documents (Windows)

1

2
3.
4

5.

Load paper in the tray. For more information, see Load paper.
From your software, select Print.

Make sure your printer is selected.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer
Setup, Printer Properties, Printer, or Preferences.

|‘__*:"/%9NOTE: To set print settings for all print jobs, make the changes in the HP software provided

with the printer. For more information on the HP software, see Printer management tools.

Select the appropriate options.
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e  On the Layout tab, select Portrait or Landscape orientation.

e On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list
in the Tray Selection area, and then select the appropriate print quality in the Quality
Settings area.

e Click the Advanced button, in the Paper/Output area, select the appropriate paper size from
the Paper Size drop-down list.

E/NNOTE: If you change the Paper Size ensure that you have loaded the correct paper and
set the paper size on the printer control panel to match.

For more printing options, see Tips for print success.

6. Click OK to close the Properties dialog box.
7. Click Print or OK to begin printing.

To print documents (OS X)
1 Load paper in the tray. For more information, see Load paper.
2. From the File menu in your software, choose Print.
3. Make sure your printer is selected.
4. Specify the page properties.

If you do not see options on the Print dialog, click Show Details.

E/?’NOTE: The following options are available for your printer. Locations for the options can vary
from one application to another.

e Choose the paper size.

E/NNOTE: If you change the Paper Size ensure that you have loaded the correct paper and
set the paper size on the printer control panel to match.

e  Select the orientation.
e Enter the scaling percentage.

5. Click Print.

Print brochures

To print brochures (Windows)
1 Load paper in the tray. For more information, see Load paper.
2.  On the File menu in your software application, click Print.
3. Make sure the printer you want to use is selected.
4. To change settings, click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer
Setup, Printer, or Preferences.

@NOTE: To set print settings for all print jobs, make the changes in the HP software provided
with the printer. For more information on the HP software, see Printer management tools.

5. Select the appropriate options.
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e  On the Layout tab, select Portrait or Landscape orientation.

e  On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list
in the Tray Selection area, and then select the appropriate print quality in the Quality
Settings area.

e  Click the Advanced button, in the Paper/Output area, select the appropriate paper size from
the Paper Size drop-down list.

E/?NOTE: If you change the Paper Size ensure that you have loaded the correct paper and
set the paper size on the printer control panel to match.

For more printing options, see Tips for print success.
6. Click OK.

7.  Click Print or OK to begin printing.

To print brochures (OS X)
1. Load paper in the tray. For more information, see Load paper.
2. From the File menu in your software application, click Print.
3. Make sure your printer is selected.
If you do not see options on the Print dialog, click Show Details.
4. Select a paper size from the pop-up menu.

If the Paper Size pop-up menu is not in the Print dialog, click the Page Setup button. When you
are done selecting the paper size, click OK to close Page Setup and return to the Print dialog.

E‘/??NOTE: If you change the Paper Size ensure that you have loaded the correct paper and set
the paper size on the printer control panel to match.

5. Click Paper Type/Quality from the pop-up menu, and then select the following settings:
e Paper Type: The appropriate brochure paper type
e  Quality: Normal or Best

6. Select any other print settings that you want, and then click Print to begin printing.

Print on envelopes

Avoid envelopes with the following characteristics:

e  Very slick finish

e Self-stick adhesives, clasps, or windows

e  Thick, irregular, or curled edges

e Areas that are wrinkled, torn, or otherwise damaged

Make sure the folds of envelopes you load in the printer are sharply creased.

E/?’NOTE: For more information about printing on envelopes, see the documentation available with the
software program you are using.
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To print envelopes (Windows)

1

2
3.
4

5.

6.

Load envelopes in the tray. For more information, see Load paper.
On the File menu in your software, click Print.

Make sure your printer is selected.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer
Setup, Printer Properties, Printer, or Preferences.

E/?’NOTE: To set print settings for all print jobs, make the changes in the HP software provided
with the printer. For more information on the HP software, see Printer management tools.

Select the appropriate options.
e On the Layout tab, select Portrait or Landscape orientation.

e On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list
in the Tray Selection area, and then select the appropriate print quality in the Quality
Settings area.

e Click the Advanced button, in the Paper/Output area, select the appropriate paper size from
the Paper Size drop-down list.

%%NOTE: If you change the Paper Size, ensure that you load the correct paper into the
printer, and set the paper size on the printer control panel to match.

For more printing options, see Tips for print success.

Click OK, and then click Print or OK in the Print dialog box.

To print envelopes (OS X)

1

2
3.
4

5.

Load envelopes print-side down in the tray. For more information, see Load paper.
From the File menu in your software, choose Print.

Make sure your printer is selected.

Set the print options.

If you do not see options on the Print dialog, click Show Details.

=¥ NOTE: The following options are available for your printer. Locations for the options can vary
from one application to another.

a. Select the appropriate envelope size from the Paper Size pop-up menu.

E/E?NOTE: If you change the Paper Size ensure that you have loaded the correct paper and
set the paper size on the printer control panel to match.

b. From the pop-up menu, choose Paper Type/Quality, and verify the paper type setting is set
to Plain Paper.

Click Print.

Print photos

Do not leave unused photo paper in the input tray. The paper might start to curl, which could impair
the quality of your printout. Photo paper should be flat before printing.

ENWW

Print photos
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To print a photo from the computer (Windows)

1.

2
3.
4

6.
7.

Load paper in the tray. For more information, see Load paper.
From your software, select Print.

Make sure your printer is selected.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer
Setup, Printer Properties, Printer, or Preferences.

Select the appropriate options.
e  On the Layout tab, select Portrait or Landscape orientation.

e  On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list
in the Tray Selection area, and then select the appropriate print quality in the Quality
Settings area.

e  Click the Advanced button, in the Paper/Output area, select the appropriate paper size from
the Paper Size drop-down list.

E/}’NOTE: If you change the Paper Size, ensure that you have loaded the correct paper and
set the paper size on the printer control panel to match.

For more printing options, see Tips for print success.

E"/f’NOTE: For maximum dpi resolution, go to Paper/Quality tab, select Photo Paper from the

Media drop-down list, and then click the Advanced button and select Yes from the Print in Max
DPI drop-down list. If you want to print max DPI in grayscale, select High Quality Grayscale from
the Print in Grayscale drop-down list.

Click OK to return to the Properties dialog box.
Click OK, and then click Print or OK in the Print dialog box.

@NOTE: After the printing is finished, remove unused photo paper from the input tray. Store the photo
paper so it does not start to curl, which could reduce the quality of your printout.

To print a photo from the computer (OS X)
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1.

2
3.
4

Load paper in the tray. For more information, see Load paper.
From the File menu in your software, choose Print.

Make sure your printer is selected.

Set the print options.

If you do not see options on the Print dialog, click Show Details.

E,%"NOTE: The following options are available for your printer. Locations for the options can vary
from one application to another.

a. Choose the appropriate paper size in the Paper Size pop-up menu.

E/?NOTE: If you change the Paper Size ensure that you have loaded the correct paper and
set the paper size on the printer control panel to match.

b. Select an Orientation.

c. From the pop-up menu, choose Paper Type/Quality, and then choose the following

settings:
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5.

e Paper Type: The appropriate photo paper type
e  Quality: Best or Maximum dpi

e Click the Color Options disclosure triangle, and then choose the appropriate Photo Fix
option.

° Off: applies no changes to the image.
° Basic: automatically focuses the image; moderately adjusts image sharpness.

Select any other print settings you want, and then click Print.

Print on special and custom-size paper

If your application supports custom-size paper, set the size in the application before printing the
document. If not, set the size in the printer driver. You might need to reformat existing documents to
print them correctly on custom-size paper.

To set up custom sizes (Windows)

1.

o > 0N

Depending on your operating system, do one of the following:

e Windows 8.1 and Windows 8: Point to or tap the upper-right corner of the screen to open
the Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap
View devices and printers. Click or tap the printer name, and click or tap Print server
properties.

e Windows 7: From the Windows Start menu, click Devices and Printers. Select the printer
name, and select Print server properties.

e Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.
Right-click an empty area in the Printers window, and select Server Properties.

e Windows XP: From the Windows Start menu, click Control Panel, and then click Printers
and Faxes. From the File menu, click Server Properties.

Select the Create a new form check box.
Enter the name of the custom size paper.
Enter the dimensions of the custom size in the Form description (measurements) section.

Click Save Form, and then click Close.

To print on special or custom-size paper (Windows)

E’)?NOTE: Before you can print on custom-size paper, you must set up the custom size in the Print
Server Properties.

ENWW

1

2
3.
4

Load the appropriate paper in the tray. For more information, see Load paper.
From the File menu in your software application, click Print.

Make sure your printer is selected.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer
Setup, Printer Properties, Printer, or Preferences.

@NOTE: To set print settings for all print jobs, make the changes in the HP software provided

with the printer. For more information on the HP software, see Printer management tools.

Print on special and custom-size paper
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5.
6.

On the Layout tab or Paper/Quality tab, click the Advanced button.

In the Paper/Output area, select the custom size from the Paper Size drop-down list.

E’/?"NOTE: If you change the Paper Size ensure that you have loaded the correct paper and set

7.
8.

the paper size on the printer control panel to match.

Select any other print settings that you want, and then click OK.

Click Print or OK to begin printing.

To set up custom sizes (OS X)

1.

2.

Depending on your operating system, do one of the following:

e  From the File menu in your software application, click Page Setup, and then make sure the
printer you want to use is selected in the Format For pop-up menu.

e From the File menu in your software application, click Print, and then make sure the printer
you want to use is selected.

Select Manage Custom Sizes in the Paper Size pop-up menu.

E}?NOTE: If you do not see these options in the Print dialog, click the disclosure triangle next to

5.

the Printer pop-up menu or click Show Details.

Click the + on the left side of the screen, double-click Untitled, and type a name for the new
custom size.

In the Width and Height boxes, type the dimensions, and then set the margins, if you want to
customize them.

Click OK.

To print on special or custom-size paper (OS X)

Before you can print on custom-size paper, you must set up the custom size in the the HP software.

1.
2.
3.

Load the appropriate paper in the tray. For more information, see Load paper.
From the File menu in your software application, click Print.

Make sure your printer is selected.

If you do not see options on the Print dialog, click Show Details.

Select a paper size from the pop-up menu.

If the Paper Size pop-up menu is not in the Print dialog, click the Page Setup button. When you
are done selecting the paper size, click OK to close Page Setup and return to the Print dialog.

E}?NOTE: If you change the Paper Size ensure that you have loaded the correct paper and set
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the paper size on the printer control panel to match.

Click Paper Handling from the pop-up menu.
Under Destination Paper Size, click Scale to fit paper size.

Select any other print settings that you want, and then click Print to begin printing.
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Print on both sides (duplexing)

You can print on both sides of a sheet of paper automatically by using the automatic two-sided
printing mechanism (duplexer).

To print on both sides of the page (Windows)
1. From your software, select Print.
2. Make sure your printer is selected.
3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer
Setup, Printer Properties, Printer, or Preferences.

@NOTE: To set print settings for all print jobs, make the changes in the HP software provided
with the printer. For more information on the HP software, see Printer management tools.

4. Select the appropriate options.

e On the Layout tab, select Portrait or Landscape orientation, and select Flip on Long Edge
or Flip on Short Edge from the Print on Both Sides drop-down list.

e On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list
in the Tray Selection area, and then select the appropriate print quality in the Quality
Settings area.

e Click the Advanced button, in the Paper/Output area, select the appropriate paper size from
the Paper Size drop-down list.

%/{’NOTE: If you change the Paper Size ensure that you have loaded the correct paper and
set the paper size on the printer control panel to match.

For more printing options, see Tips for print success.
5. Click OK to print.
To print on both sides of the page (OS X)
1. From the File menu in your software, choose Print.

2. In the Print dialog, choose Layout from the pop-up menu.

3. Choose the type of binding you want for your two-sided pages, and then click Print.

Print using the maximum dpi

Use the maximum dots per inch (dpi) mode to print high-quality, sharp images on photo paper.

Printing in maximum dpi takes longer than printing with other settings and requires a large amount of
memory.

To print in maximum dpi mode (Windows)
1. From your software, select Print.

2. Make sure your printer is selected.
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3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer
Setup, Printer Properties, Printer, or Preferences.

E}fNOTE: To set print settings for all print jobs, make the changes in the HP software provided
with the printer. For more information on the HP software, see Printer management tools.

Click the Paper/Quality tab.

From the Media drop-down list, select an appropriate paper type.
Click the Advanced button.

In the Printer Features area, select Yes from the Print in Max DPI drop-down list.

© N o o &

Select the appropriate paper size from the Paper Size drop-down list.

E/?NOTE: If you change the Paper Size ensure that you have loaded the correct paper and set
the paper size on the printer control panel to match.

9. Click OK to close the advanced options.

10. Confirm Orientation on the Layout tab, and then click OK to print.
To print using maximum dpi (OS X)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Set the print options.

If you do not see options on the Print dialog, click Show Details.

|‘__*:"/;’NOTE: The following options are available for your printer. Locations for the options can vary
from one application to another.

a. Choose the appropriate paper size in the Paper Size pop-up menu.

E/%"NOTE: If you change the Paper Size ensure that you have loaded the correct paper and
set the paper size on the printer control panel to match.

b. From the pop-up menu, choose Paper Type/Quality, and then choose the following
settings:

e Paper Type: The appropriate paper type
e  Quality: Maximum dpi

4. Select any other print settings that you want, and then click Print.

Tips for print success

Software settings selected in the print driver only apply to printing.

You can print your document on both sides of the paper. For more information, see Print on both
sides (duplexing).

Ink tips

e If the print quality is not acceptable, see Print quality diagnostic report for more information.

e  Use Original HP ink cartridges.
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Install both the black and color cartridges correctly.

For more information, see Replace the ink cartridges.

Check the estimated ink levels in the cartridges to make sure there is sufficient ink.

For more information, see Check the estimated ink levels.

Always turn off the printer with the (1) (Power) button to allow the printer to protect the nozzles.

Paper loading tips

For more information, also see Load paper.

Ensure the paper loaded in the tray matches the currently set paper size for the printer. For
more information, see Set the paper size for the printer.

Load a stack of paper (not just one page). All the paper in the stack should be of the same size
and type to avoid a paper jam.

Load paper with the print-side down.
Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.

Adjust the paper-width guides in the input tray to fit snugly against all paper. Make sure the
guides do not bend the paper in the tray.

Printer settings tips (Windows)
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To change default print settings, click Print, and then click Set Preferences in the HP printer
software.

For information on opening your HP printer software, see Open the HP printer software

(Windows).

To select the number of pages to print per sheet, on the Layout tab of the printer driver, select
the appropriate option from the Pages per Sheet drop-down list.

@NOTE: The preview on the Layout tab cannot reflect what you select from the Pages per Sheet
Layout, the Booklet, or the Page Borders drop-down lists.

If you want to change the page orientation, set it in your application interface.

To view more printing settings, on the Layout or Paper/Quality tab of the printer driver, click the
Advanced button to open the Advanced Options dialog box.

° Print in Grayscale: Allows you to print a black and white document using the black ink only.
Select Black Ink Only, and then click the OK button.

° Pages per Sheet Layout: Helps you specify the order of the pages if you print document in
more than two pages per sheet.

° Borderless Printing: Select this feature to print photos without border. Not all paper types
support this feature. You will see an alert icon beside the option if the selected paper type
in the Media drop-down list does not support it.

o Layout: This feature only works with the duplex printing. If the image is larger than the
printable area, select this feature to scale the page content to be within the smaller margins
so that extra pages are not created.

° HP Real Life Technologies: This feature smooths and sharpens images and graphics for
improved print quality.
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° Booklet: Allows you to print a multiple-page document as a booklet. It places two pages on
each side of a sheet that can then be folded into a booklet in half size of the paper. Select a
binding method from the drop-down list, and then click OK.

e Booklet-LeftBinding: The binding side after folded into a booklet appears at the left
side. Select the option if your reading habit is from left to right.

e Booklet-RightBinding: The binding side after folded into a booklet appears at the right
side. Select the option if your reading habit is from right to left.

o Page Borders: Allows you to add the borders to the pages if you print the document with
two or more pages per sheet.

You can use printing shortcut to save time setting printing preferences. A printing shortcut stores
the setting values that are appropriate for a particular kind of job, so that you can set all the
options with a single click. To use it, go to the Printing Shortcut tab, select one printing shortcut,
and then click OK.

To add a new printing shortcut, after making settings on the Layout or Paper/Quality tab, click
the Printing Shortcut tab, click Save As and enter a name, and then click OK.

To delete a printing shortcut, select it, and then click Delete.

@NOTE: You cannot delete the default printing shortcuts.

Printer settings tips (OS X)

Notes

On the Print dialog, use the Paper Size pop-up menu to select the size of paper loaded in the
printer.

On the Print dialog, choose the Paper Type/Quality pop-up menu and select the appropriate
paper type and quality.

To print a black and white document using only black ink, choose the Paper Type/Quality from
the pop-up menu. Then click the Color Options disclosure triangle and choose Grayscale from
the Color pop-up menu and select Black Print Cartridge Only.

Original HP ink cartridges are designed and tested with HP printers and papers to help you
easily produce great results, time after time.

=»NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Product service or

repairs required as a result of using a non-HP supply will not be covered under warranty.

If you believe you purchased Original HP ink cartridges, go to www.hp.com/go/anticounterfeit.

Ink level warnings and indicators provide estimates for planning purposes only.

E‘%NOTE: When you receive a low-ink warning message, consider having a replacement cartridge

available to avoid possible printing delays. You do not need to replace the cartridges until print
quality becomes unacceptable.

Print with AirPrint™

Printing using Apple’s AirPrint is supported for iOS 4.2 and Mac OS X 10.7 or later. Use AirPrint to
print wirelessly to the printer from an iPad (iOS 4.2), iPhone (3GS or later), or iPod touch (third
generation or later) in the following mobile applications:
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e Mail

e Photos

e  Safari

e  Supported third-party applications, for example Evernote
To use AirPrint, ensure the following:

e The printer must be connected to the same network as your AirPrint enabled device. For more
information about using AirPrint and about which HP products are compatible with AirPrint, go to
www.hp.com/go/mobileprinting.

e Load paper that matches the paper settings of the printer (see Load paper and Set the paper
size for the printer for more information). Accurately setting the paper size for the paper that is
loaded, enables a mobile device to know what paper size it is printing.

Set the paper size for the printer

When you pull out the input tray, one or all the Paper Size Selection lights will blink (see Control
panel lights reference for printer lights behaviors).

If you are loading a paper size that is not listed on the control panel, change the paper size in the HP
printer software or the embedded web server (EWS). For information on how to open the printer’s
EWS, see Open the embedded web server.

E’%NOTE: If you pull out the input tray when there is a paper path related error, there will be no change
to the way the Paper Size Selection lights are currently lit.

To change the current paper size from the printer control panel

A Continue to press the |__EI (Paper Size Selection) button until the desired paper size is selected
(as indicated by the Paper Size Selection light).

E’%NOTE: If you have loaded a paper size that is not one of the sizes listed on the control panel, then
the paper size will need to be set in the EWS. For information on how to open the printer's EWS, see
Open the embedded web server.
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4 HP ePrint

HP ePrint is a free service from HP that allows you to print to your HP ePrint-enabled printer anytime,
from any location. It's as simple as sending an email to the email address assigned to your printer
when you enable Web Services on the printer. No special drivers or software are needed. If you can
send an email, you can print from anywhere, using HP ePrint.

Once you have signed up for an account on HP Connected (www.hpconnected.com), you can sign in
to view your HP ePrint job status, manage your HP ePrint printer queue, control who can use your
printer's HP ePrint email address to print, and get help for HP ePrint.

@NOTE: To use HP ePrint, the printer must be connected to an active network providing Internet
access. You cannot use these web features if the printer is connected using a USB cable.

For more information about the HP ePrint button and light patterns, see Control panel lights
reference.

This section contains the following topics:
e  Set up HP ePrint
e Use HP ePrint

° Remove Web Services

Set up HP ePrint

To set up HP ePrint, use one of the following methods:

@NOTE: Before you set up HP ePrint, make sure your printer is connected using either an Ethernet or
wireless connection.

To set up HP ePrint using the embedded web server

1. Open the embedded web server (EWS). For more information, see Open the embedded web
server.

2. Click the Web Services tab.

In the Web Services Settings section, click Setup, and then follow the on-screen instructions.

4. If prompted, choose to allow the printer to check for and install printer updates.

E’/?NOTE: If a printer update is available, the printer downloads and installs the update, and then
restarts.

|‘__*:"/%9NOTE: If prompted for proxy settings and if your network uses proxy settings, follow the on-
screen instructions to set up a proxy server. If you do not have the proxy details, contact your
network administrator or the person who set up the network.

5.  When the printer is connected to the server, the printer prints an information page. Follow the
instructions on the information page to finish the setup.
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To set up HP ePrint using the HP printer software (Windows)

1.  Open the HP printer software. For more information, see Open the HP printer software

(Windows).

2. Inthe window that appears, double-click Print, and then select Connect your printer to the web
under Print. The printer's home page (embedded web server) opens.

Click the Web Services tab.

4. Inthe Web Services Settings section, click Setup, and then follow the on-screen.

If prompted, choose to allow the printer to check for and install printer updates.

= : a printer update is available, the printer downloads and installs the update, an en
WNOTE If int date i ilable, th inter d load d installs th dat d th
restarts.

@NOTE: If prompted for proxy settings and if your network uses proxy settings, follow the on-
screen instructions to set up a proxy server. If you do not have the proxy details, contact your
network administrator or the person who set up the network.

6. When the printer is connected to the server, the printer prints an information page. Follow the
instructions on the information page to finish the setup.

Use HP ePrint

HP ePrint allows you to print to your HP ePrint-enabled printer anytime, from any location.
To use HP ePrint, make sure to have the following:
e An Internet- and email-capable computer or mobile device

e An HP ePrint-capable printer on which Web Services has been enabled

*O-TIP:  For more information about managing and configuring HP ePrint settings and to learn about the
"*" latest features, visit HP Connected at www.hpconnected.com.

To print documents using HP ePrint
1. Enable Web Services.

2.  On your computer or mobile device, open your email application.

=¥ NOTE: For information about using the email application on your computer or mobile device,
see the documentation provided with the application.

3. Create a new email message, and then attach the file that you want to print.

4. Enter the printer's email address in the “To” line of the email message, and then select the
option to send the email message.

%NOTE: The HP ePrint server does not accept email print jobs if there are multiple email
addresses included in the "To" or "Cc" fields. Only enter the email address of your HP printer in
the "To" field. Do not enter any additional email addresses in the other fields.
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To find the printer's email address

1. Make sure you have created an ePrint account.

To sign up for an account, visit HP Connected at www.hpconnected.com.

2. Fromthe printer control panel, press the El?"-l (HP ePrint) button and the ® (Information) button
together.

The printer prints an information page that contains the printer's email address.
To turn off HP ePrint

A From the printer control panel, press the Erj (HP ePrint) button.

@NOTE: To remove all Web Services, see Remove Web Services.

Remove Web Services

To remove Web Services, complete the following steps:

1. Open the embedded web server (EWS). For more information, see Open the embedded web
server.

2. Click the Web Services tab, and then click Remove Web Services in the Web Services Settings
section.

Click Remove Web Services.

4. Click Yes to remove Web Services from your printer.
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5 Work with ink cartridges

This section contains the following topics:

° Information on ink cartridges and the printhead

e Check the estimated ink levels

° Replace the ink cartridges

e  Order ink cartridges

° Store printing supplies

e Anonymous usage information storage

° Ink cartridge warranty information

Information on ink cartridges and the printhead

The following tips help maintain HP ink cartridges and ensure consistent print quality.

e The instructions in this user guide are for replacing ink cartridges, and are not intended for first
time installation. For the first time installation, follow the instructions in the setup poster provided
with the printer.

e  When you turn the printer off, always use the () (Power) button. This allows the printer to cap
the printhead and protect it from damage. For more information, see Turn the printer off.

e Do not clean the printhead unnecessarily. This wastes ink and shortens the life of the cartridges.

e Handle ink cartridges carefully. Dropping, jarring, or rough handling during installation can cause
temporary printing problems.

e If you are transporting the printer, do the following to prevent ink leaking from the printer or other
damage from occurring to the printer:

° Make sure you turn off the printer by pressing the (I3 (Power) button. Wait until all sounds of
internal motion stop before unplugging the printer. For more information, see Turn the
printer off.

0 The printer must be transported sitting flat; it should not be placed on its side, back, front, or
top.

/\ CAUTION: HP recommends that you replace any missing cartridges as soon as possible to avoid
print quality issues and possible extra ink usage or damage to the ink system. Never turn off the
printer when ink cartridges are missing.

Check the estimated ink levels

You can check the estimated ink levels from the HP printer software or from the printer control panel.
For information about using the HP printer software, see Printer management tools.
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To check the estimated ink levels from the printer control panel

A Ppress and hold the x (Cancel) button for five seconds to print the printer status report.

@NOTE: Ink level alerts and indicators provide estimates for planning purposes only. When you
receive a low-ink alert, consider having a replacement cartridge available to avoid possible printing
delays. You do not have to replace the cartridges until the print quality becomes unacceptable.

@NOTE: If you have installed a refilled or remanufactured cartridge, or a cartridge that has been used
in another printer, the ink level indicator might be inaccurate or unavailable.

@NOTE: Ink from the cartridges is used in the printing process in a number of different ways,
including in the initialization process, which prepares the printer and cartridges for printing, and in
printhead servicing, which keeps print nozzles clear and ink flowing smoothly. In addition, some
residual ink is left in the cartridge after it is used. For more information, see www.hp.com/go/

inkusage.

Replace the ink cartridges

If you do not already have replacement ink cartridges for the printer, see Order ink cartridges. Not all
cartridges are available in all countries/regions.

/\ CAUTION: HP recommends that you replace any missing cartridges as soon as possible to avoid
print quality issues and possible extra ink usage or damage to the ink system. Never turn off the

printer when ink cartridges are missing.

For information on recycling used ink supplies, see HP inkjet supplies recycling program.

To replace the ink cartridges
1. Make sure the printer is turned on.

2. Open the ink cartridge access door.

E%,@NOTE: Wait until the print carriage stops moving before proceeding.

3.
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4. Remove the new ink cartridge from its packaging.

[,
|
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5. Using the color-coded letters for help, slide the ink cartridge into the empty slot until it clicks
securely into the slot.

Make sure that you insert the ink cartridge into the slot that has the same colored letter as the
color you are installing.

1=

- 1

6. Repeat steps 3 through 5 for each ink cartridge you are replacing.

7. Close the ink cartridge access door.

Order ink cartridges

To order ink cartridges, go to www.hp.com. (At this time, some portions of the HP website are
available in English only.) Ordering cartridges online is not supported in all countries/regions.
However, many countries have information on ordering by telephone, locating a local store and
printing a shopping list. In addition, you can visit the www.hp.com/buy/supplies page to obtain
information about purchasing HP products in your country.

Use only the replacement cartridges that have the same cartridge number as the ink cartridge you are
replacing. You can find the cartridge number in the following places:
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e Inthe embedded web server, by clicking the Tools tab, and then, under Product Information
clicking Ink Gauge. For more information, see Embedded web server.

e  On the printer status report (see Printer status report).

e  On the label of the ink cartridge you are replacing.
e On a sticker inside the printer. Open the ink cartridge access door to locate the sticker.

e In the printer software, click Shop, and then click Shop For Supplies Online.

@NOTE: The Setup ink cartridge that comes with the printer is not available for separate purchase.

Store printing supplies
e Keep all ink cartridges in the original sealed packages until they are needed.

e Ink cartridges can be left in the printer for extended periods of time. However, to assure optimal
ink cartridge health, be sure to turn off the printer properly. For more information, see Turn the

printer off.
e  Store ink cartridges at room temperature (15-35° C or 59-95° F).

Anonymous usage information storage

The HP cartridges used with this printer contain a memory chip that assists in the operation of the
printer. In addition, this memory chip stores a limited set of anonymous information about the usage
of the printer, which might include the following: the number of pages printed using the cartridge, the
page coverage, frequency of printing, and the printing modes used.

This information helps HP design future printers to meet our customers' printing needs. The data
collected from the cartridge memory chip does not contain information that can be used to identify a
customer or user of the cartridge or their printer.

HP collects a sampling of the memory chips from cartridges returned to HP's free return and recycling
program (HP Planet Partners: www.hp.com/recycle). The memory chips from this sampling are read
and studied in order to improve future HP printers. HP partners who assist in recycling this cartridge
might have access to this data, as well.

Any third party possessing the cartridge might have access to the anonymous information on the
memory chip. If you prefer to not allow access to this information, you can render the chip inoperable.
However, after you render the memory chip inoperable, the cartridge cannot be used in an HP printer.

If you are concerned about providing this anonymous information, you can make this information
inaccessible by turning off the memory chip's ability to collect the printer's usage information.

To disable the usage information function

A Onthe printer control panel, press and hold the B (Resume) button and the @ (Information)
button together approximately five seconds, and then release the buttons.

E/?’NOTE: The usage information function may be turned back on using the EWS. For information on
how to open the printer's EWS, see Open the embedded web server.

@NOTE: You can continue to use the cartridge in the HP printer if you turn off the memory chip's
ability to collect the printer's usage information.

44 Chapter 5 Work with ink cartridges ENWW


http://www.hp.com/recycle

Ink cartridge warranty information

The HP cartridge warranty is applicable when the product is used in its designated HP printing
device. This warranty does not cover HP ink products that have been refilled, remanufactured,
refurbished, misused, or tampered with.

During the warranty period the product is covered as long as the HP ink is not depleted and the end
of warranty date has not been reached. The end of warranty date, in YYYY-MM format, may be found
on the product as indicated:
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6 Network setup

Additional advanced settings are available from the printer's embedded web server (EWS). For more
information, see Embedded web server.

e Set up the printer for wireless communication

e Change network settings

° Use HP wireless direct

Set up the printer for wireless communication

° Before you begin

e Set up the printer on your wireless network

e Change the connection type

e Test the wireless connection

@NOTE: If you encounter problems connecting the printer, see Unable to connect the printer
wirelessly.

_‘{}: TIP: For more information about setting up and using the printer wirelessly, visit the HP Wireless
“*" Printing Center (www.hp.com/go/wirelessprinting).

Before you begin

Ensure the following:

e The printer is not connected to the network using an Ethernet cable.

e The wireless network is set up and working properly.

e  The printer and the computers that use the printer are on the same network (subnet).

e  During network setup, a USB cable might be required for temporary connection, have one ready
on hand and insert it when prompted.

While connecting the printer, you might be prompted to enter the wireless network name (SSID) and
a wireless password.

e The wireless network name is the name of your wireless network.

e The wireless password prevents other people from connecting to your wireless network without
your permission. Depending on the level of security required, your wireless network might use
either a WPA passphrase or WEP key.

If you have not changed the network name or the security passkey since setting up your wireless
network, you can sometimes find them on the back or side of the wireless router.

If you cannot find the network name or the security password or cannot remember this information,
see the documentation provided with your computer or with the wireless router. If you still cannot find
this information, contact your network administrator or the person who set up the wireless network.

For more information about the Wireless button and light patterns, see Control panel lights reference.
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Set up the printer on your wireless network

You may print a Wireless Quick Start Guide to aide in the setup of the printer on a wireless network.

To print a wireless quick start guide

ress an (0] e nrormation) putton 1or three secondads.
A p d hold th (Information) button for th d

To set up the wireless connection using the HP printer software

1.

2.

If you have not yet installed the HP printer software, insert the HP software CD into your
computer, and then complete the following steps:

e (Windows): When prompted, click Wireless, and then follow the on-screen instructions.

e (OS X): Double-click the HP Installer icon on the software CD, and then follow the on-
screen instructions.

If you have already installed the HP printer software on your computer, complete the following
steps:

Windows

a. Open the printer software. For more information, see Open the HP printer software

(Windows).
b. Windows 8 and 8.1: Click Utilities.

c. Click Printer Setup & Software.

d. Click Connect a new printer, and then follow the on-screen instructions.

0S X

a. Double-click the HP Utility icon (located in the Hewlett-Packard folder in the Applications
folder at the top level of the hard disk).

b. From the Devices menu, click Setup New Device, and then follow the on-screen
instructions.

After the printer connects successfully, the blue Wireless light stops blinking and remains on.

To set up the wireless connection from the printer control panel

ENWW

Ensure your wireless router or wireless access point has a Wi-Fi Protected Setup (WPS) button (a
button with the ‘@'— icon or is labeled “WPS”), and that WPS is enabled with WPA encryption.

1.

From the printer control panel, press and hold the ({'}) (Wireless) button for three seconds. The
Wireless light starts blinking.

On the wireless router or wireless access point, press and hold the WPS button for three
seconds. Wait for about two minutes. If the printer connects successfully, the Wireless light will
stop blinking and remain lit.

(Windows): After you have completed the wireless setup, add the printer in your computer by
choosing Add a Network Printer from Control Panel, and then follow the on-screen instructions.

(OS X): After you have completed the wireless setup, add the printer in your computer by
choosing System Preferences, and then follow the on-screen instructions.
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If you are already using the printer with a different type of connection, such as a USB connection,
follow the instructions in Change the connection type to set up the printer on your wireless network.

Change the connection type

After you have installed the HP printer software and connected the printer to your computer or to a
network, you can use the software to change the connection type (for example, from a USB
connection to a wireless connection).

E/?’NOTE: Connecting an Ethernet cable turns off the wireless capability of the printer.

To change from an Ethernet connection to a wireless connection (Windows)

Before you proceed, go through the list at Before you begin.

E/?’NOTE: A USB cable will be used temporarily during the setup process.

1. Remove the Ethernet cable from the printer.

2. Open the printer software after the installation. For more information, see Open the HP printer
software (Windows).

Windows 8 and 8.1: Click Utilities.
4. Click Printer Setup & Software.

Click Reconfigure wireless settings.

To change from an Ethernet connection to a wireless connection (OS X)

Before you proceed, go through the list at Before you begin.

1. Connect the printer to your wireless network.

2. Use HP Setup Assistant in Applications/Hewlett-Packard/Device Utilities to change the software
connection to wireless for this printer.

To change from a USB connection to a wireless network (Windows)

Before you proceed, go through the list at Before you begin.

1. Depending on your operating system, do one of the following:

e  Windows 8.1: Click the down arrow in lower left corner of the Start screen, select the printer
name, and then click Utilities.

¢ Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar,
select the printer name, and then click Utilities.

e Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start,
select All Programs, click HP, click the folder of your printer.

2.  Click Printer Setup & Software.
3. Select Convert a USB connected printer to wireless. Follow the on-screen instructions.
To change from a USB connection to a wireless network (OS X)

Before you proceed, go through the list at Before you begin.
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1. Connect the printer to your wireless network.

2. Use HP Setup Assistant in Applications/Hewlett-Packard/Device Utilities to change the software
connection to wireless for this printer.

@ Learn more about how to change from a USB to wireless connection. Click here to go online

for more information. At this time, this website might not be available in all languages.

To change from a wireless connection to a USB or Ethernet connection (Windows)

e  Connect the USB or Ethernet cable to the printer.

To change from a wireless connection to a USB or Ethernet connection (OS X)
Add the printer to the print queue.
1. Open System Preferences.

2. Depending on your operating system, click Print & Fax, Print & Scan, or Printers & Scanners in
the Hardware section.

Click + below the list of printers at the left.

4. Select the printer from the list of detected printers, and click Add.

Test the wireless connection

Print the wireless network test report for information about the printer wireless connection. The
wireless network test report provides information about the printer status, hardware (MAC) address,
and IP address. If the printer is connected to a network, the test report displays details about the
network settings.

To print the wireless network test report

A Ppressthe ({'}) (Wireless) button and the ® (Information) button together to print the network
configuration page and the wireless network test report.

You may also test the wireless setup using the EWS. To open the EWS, see Embedded web server.

Change network settings

You can set up and manage your printer wireless connection and perform a variety of network
management tasks. This includes printing information about network settings, turning the wireless
function on or off, setting the link speed, and changing IP settings.

/\ CAUTION: Network settings are provided for your convenience. However, unless you are an
advanced user, you should not change some of these settings (such as the link speed, IP settings,
default gateway, and firewall settings).

To print network settings

®  Pressthe ({'}) (Wireless) button and the @ (Information) button together to print the network
configuration page and the wireless network test report.
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To turn on or off the wireless capability of the printer

The blue Wireless light on the printer control panel is lit when the wireless capability of the printer is
on.

@NOTE: Connecting an Ethernet cable to the printer automatically turns off the wireless capability
and the Wireless light.

A From the printer control panel, press the ({'}) (Wireless) button to turn the wireless capability on
or off.
To change network settings using the embedded web server

Use the printer's embedded web server (EWS) to modify network settings such as link speed and IP
settings.

1.  Open the embedded web server (EWS). For more information, see Open the embedded web
server.

2. Click the Network tab, and then click the different network items to make changes.

Use HP wireless direct

With HP wireless direct, you can print wirelessly from a computer, smart phone, tablet, or other
wireless-capable device—without connecting to an existing wireless network.

For more information about the HP wireless direct button and light patterns, see Control panel lights
reference.

You may print an HP Wireless Direct Guide as a reference for HP wireless direct.

To print the HP Wireless Direct Guide

®  Pressing the @ (HP wireless direct) button the first time will turn on HP wireless direct and print

the HP Wireless Direct Guide. The guide includes the HP wireless direct network name and
password.

®  After the first time, you can press the @ (HP wireless direct) button and the ® (Information)
button together to print the HP Wireless Direct Guide.

Guidelines when using HP wireless direct

e  Make sure your computer or mobile device has the necessary software.

If you are using a computer, make sure you have installed the printer software provided with the
printer.

e If you have not installed the HP printer software on the computer, connect to HP wireless direct
first and then install the printer software. Select Wireless when prompted by the printer software
for a connection type.

e If you are using a mobile device, make sure you have installed a compatible printing app. For
more information about mobile printing, visit www.hp.com/global/us/en/eprint/
mobile printing apps.html.

e Make sure HP wireless direct is turned on in the printer and, if necessary, security is enabled.

e Up to five computers and mobile devices can use the same HP wireless direct connection.
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e HP wireless direct can be used while the printer is also connected either to a computer using a
USB cable or to a network using a wireless connection.

e HP wireless direct cannot be used to connect a computer, mobile device, or printer to the
Internet.

To turn on HP wireless direct

A Onthe printer control panel, press the @ (HP wireless direct) button to turn the HP wireless
direct feature on.

If this is the first time you are pressing the button, the printer prints the HP Wireless Direct Guide
automatically. The guide includes the network name and password for HP wireless direct.

To print from a wireless-capable mobile device

Make sure you have installed a compatible printing app on your mobile device. For more information,
visit www.hp.com/global/us/en/eprint/mobile printing apps.html.

1. Make sure you have turned on HP wireless direct on the printer.

2. Turn on the Wi-Fi connection on your mobile device. For more information, see the
documentation provided with the mobile device.

@NOTE: If your mobile device does not support Wi-Fi, you are not able to use HP wireless
direct.

3. From the mobile device, connect to a new network. Use the process you normally use to
connect to a new wireless network or hotspot. Choose the HP wireless direct name from the list
of wireless networks shown such as HP-Print-**-Officejet Pro XXXX (where ** are the unique
characters to identify your printer and XXXX is the printer model located on the printer).

If HP wireless direct is turned on with security, enter the password when prompted.

4. Print your document.

To print from a wireless-capable computer (Windows)
1. Make sure you have turned on HP wireless direct on the printer.

2. Turn on the computer's Wi-Fi connection. For more information, see the documentation provided
with the computer.

@NOTE: If your computer does not support Wi-Fi, you are not able to use HP wireless direct.

3. From the computer, connect to a new network. Use the process you normally use to connect to
a new wireless network or hotspot. Choose the HP wireless direct name from the list of wireless
networks shown such as HP-Print-**-Officejet Pro XXXX (where ** are the unique characters to
identify your printer and XXXX is the printer model located on the printer).

If HP wireless direct is turned on with security, enter the password when prompted.

4. Proceed to step 5 if the printer has been installed and connected to the computer over a wireless
network. If the printer has been installed and connected to your computer with a USB cable,
follow the steps below to install the printer software using the HP HP wireless direct connection.

a. Depending on your operating system, do one of the following:
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e Windows 8.1: Click the down arrow in lower left corner of the Start screen, select the
printer name, and then click Utilities.

e Windows 8: Right-click an empty area on the Start screen, click All Apps on the app
bar, select the printer name, and then click Utilities.

e Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start,
select All Programs, click HP, click the folder of your printer.

b. Click Printer Setup & Software, and then select Connect a new printer.

c. When the Connection Options software screen appears, select Wireless.
Select your HP printer software from the list of detected printers.

d. Follow the on-screen instructions.

5.  Print your document.

To print from a wireless-capable computer (OS X)
1. Make sure you have turned on HP wireless direct on the printer.
2.  Turn on AirPort.
For more information, see the documentation provided by Apple.

3. Click the AirPort icon and choose the HP wireless direct name, such as HP-Print-**-Officejet Pro
XXXX (where ** are the unique characters to identify your printer and XXXX is the printer model
located on the printer).

If HP wireless direct is turned on with security, enter the password when prompted.
4. Add the printer.
a. Open System Preferences.

b. Depending on your operating system, click Print & Fax, Print & Scan, or Printers &
Scanners in the Hardware section.

c. Click + below the list of printers at the left.

d. Select the printer from the list of detected printers (the word “Bonjour” is listed the right
column beside the printer name), and click Add.

@ Click here for online troubleshooting for HP wireless direct, or for more help with setting up

HP wireless direct. At this time, this website might not be available in all languages.
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7 Printer management tools

This section contains the following topics:
e  Toolbox (Windows)

e  HP Utility (OS X)

° Embedded web server

Toolbox (Windows)

The Toolbox provides maintenance information about the printer.

E'%"NOTE: The Toolbox can be installed from the HP Software CD if the computer meets the system
requirements. System requirements can be found in the Readme file, which is available on the HP
printer software CD provided with your printer.

To open the Toolbox
1. Depending on your operating system, do one of the following:

e Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select
the printer name.

e Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar,
and then select the printer name.

e Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start,
select All Programs, click HP, click the folder for the printer, and then select the icon with
the printer's name.

2. Click Print.

3. Click Maintain Your Printer.

HP Utility (OS X)

HP Ultility contains tools to configure print settings, calibrate the printer, order supplies online, and find
website support information.

E’%NOTE: The features available in HP Utility vary depending on the selected printer.

Ink level warnings and indicators provide estimates for planning purposes only. When you receive
a low-ink warning message, consider having a replacement cartridge available to avoid possible
printing delays. You do not need to replace cartridges until the print quality becomes unacceptable.

Double-click HP Utility in the Hewlett-Packard folder in the Applications folder at the top level of the
hard disk.

Embedded web server

When the printer is connected to a network, you can use the printer's embedded web server (EWS) to
view status information, change settings, and manage it from your computer.
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E/?’NOTE: To view or change some settings, you might need a password.

@NOTE: You can open and use the embedded web server without being connected to the Internet.

However, some features are not available.

e  About cookies

e Open the embedded web server

° Embedded web server cannot be opened

About cookies

The embedded Web server (EWS) places very small text files (cookies) on your hard drive when you
are browsing. These files let the EWS recognize your computer the next time you visit. For example,
if you have configured the EWS language, a cookie helps remember which language you have
selected so that the next time you access the EWS, the pages are displayed in that language. Some
cookies (such as the cookie that stores customer-specific preferences) are stored on the computer
until you clear them manually.

You can configure your browser to accept all cookies, or you can configure it to alert you every time a
cookie is offered, which allows you to decide which cookies to accept or refuse. You can also use
your browser to remove unwanted cookies.

Depending on your printer, if you disable cookies, you also disable one or more of the following
features:

e Using some setup wizards
e Remembering the EWS browser language setting
e  Personalizing the EWS Home page

For information about how to change your privacy and cookie settings and how to view or delete
cookies, see the documentation available with your Web browser.

Open the embedded web server

You can access the embedded web server through either the network or HP wireless direct.

To open the embedded web server through a network

54

1. Find out the IP address or hostname of the printer from the network configuration page.

For more information, see Network configuration page.

2. Ina supported web browser on your computer, type the IP address or hostname assigned to the
printer.

For example, if the IP address is 123.123.123.123, type the following address into the web
browser: http://123.123.123.123
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To open the embedded web server through HP wireless direct
1. If the HP wireless direct light is off, press the @ (HP wireless direct) button to turn it on.

2. From your wireless computer, turn wireless on, search for and connect to the HP wireless direct
name. If you have HP wireless direct security on, enter the HP wireless direct password when
prompted.

3. In a supported Web browser on your computer, type the following address: http://
192.168.223.1.

Embedded web server cannot be opened

Check your network setup

e  Make sure you are not using a phone cord or a crossover cable to connect the printer to the
network.

e  Make sure the network cable is securely connected to the printer.
e Make sure the network hub, switch, or router is turned on and working correctly.
Check the computer

e  Make sure the computer that you are using is connected to the network.

E,%"NOTE: To use the embedded web server (EWS), the printer must be connected to a network. You
cannot use the EWS if the printer is connected to a computer with a USB cable.

Check your web browser

e  Make sure the web browser meets the minimum system requirements. For more information,
see system requirements in the printer's Readme file found on the HP printer software CD.

e If your web browser uses any proxy settings to connect to the Internet, try turning off these
settings. For more information, see the documentation available with your web browser.

e  Make sure JavaScript and cookies are enabled in your web browser. For more information, see
the documentation available with your web browser.

Check the printer IP address

®  To check the IP address of the printer, print a network configuration page. Press the ({I})

(Wireless) button and the @ (Information) button together to print the network configuration
page.

e  Ping the printer using the IP address from the command prompt (Windows) or from Network
Utility (OS X).

@NOTE: OS X Lion and OS X Mountain Lion: Network Utility is located in the Utilities folder in
the Applications folder at the top level of the hard disk.

OS X Mavericks: Open Finder, hold down the Option key and choose System Information from
the Apple (g§) menu. Choose Window > Network Utility.

For example, if the IP address is 123.123.123.123, type the following at the command prompt
(Windows):

C:\ping 123.123.123.123
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Or

In Network Utility (OS X), click the Ping tab, type the 123.123.123.123 in the box, and then click
Ping.

If a reply appears, the IP address is correct. If a time-out response appears, the IP address is
incorrect.

_‘{}: TIP: If you are using a computer running Windows, you can visit the HP online support website at
“*" www.hp.com/support. This website provides information and utilities that can help you correct many
common printer problems.
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Solve a problem

The information in this section suggests solutions to common problems. If your printer is not operating
correctly and these suggestions did not solve your problem, try using one of the following support
services to obtain assistance.

This section contains the following topics:

HP support

Understand printer reports

Solve printer problems

Solve printing problems

Solve problems using HP ePrint

Solve network problems

Maintain the printer

Clear paper jams

Reset the printer

HP support

Register printer

Support process

Obtain electronic support

HP support by phone

Register printer

By taking just a few quick minutes to register, you can enjoy quicker service, more efficient support,
and product support alerts. If you did not register your printer while installing the software, you can
register now at http://www.reqgister.hp.com.

Support process

ENWW

If you have a problem, follow these steps:

1.
2.

Check the documentation that came with the printer.

Visit the HP online support website at www.hp.com/support.

HP online support is available to all HP customers. It is the fastest source for up-to-date product
information and expert assistance, and includes the following features:

e Fast access to qualified online support specialists

e  Software and driver updates for the printer
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e  Valuable troubleshooting information for common problems

e  Proactive printer updates, support alerts, and HP newsgrams that are available when you
register the printer

3. Call HP support. For more information, see HP support by phone.

Support options and availability vary by printer, country/region, and language.

Obtain electronic support

To find support and warranty information, go to the HP website at www.hp.com/support. This website
provides information and utilities that can help you correct many common printer problems. If
prompted, select your country/region, and then click All HP Contacts for information about calling for
technical support.

This website also offers technical support, drivers, supplies, ordering information and other options
such as:

e Access online support pages.

e Send HP an email message for answers to your questions.
e  Connect with an HP technician by using online chat.

e  Check for HP software updates.

You can also obtain support from the HP software for Windows or OS X, which provide easy, step-by-
step solutions to common printing problems. For more information, see Printer management tools.

Support options and availability vary by printer, country/region, and language.

HP support by phone
Phone support options and availability vary by printer, country/region, and language.
This section contains the following topics:

° Before you call

° Phone support period

° Support phone numbers

e  After the phone support period

Before you call

Call HP support while you are in front of the printer and a computer it is connected to. Be prepared to
provide the following information:

e  Model number
e  Serial number (located on the back or bottom of the printer)
e Messages that appear when the situation occurs
e Answers to these questions:
o Has this situation happened before?

o Can you re-create it?
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° Did you add any new hardware or software to your computer at about the time that this
situation began?

° Did anything else occur prior to this situation (such as a thunderstorm or moving the
printer)?

If you need to call HP, it is often useful to print the printer status report before calling.

Phone support period

One year of phone support is available in North America, Asia Pacific, and Latin America (including
Mexico). To determine the duration of phone support in Europe, the Middle East, and Africa, go to
www.hp.com/support. Standard phone company charges apply.

Support phone numbers

For the most current HP list of telephone support numbers and call costs information, see
www.hp.com/support.

After the phone support period

After the phone support period, help is available from HP at an additional cost. Help may also be
available at the HP online support website: www.hp.com/support. Contact your HP dealer or call the
support phone number for your country/region to learn more about support options.

Understand printer reports

You can print the following reports to help troubleshoot problems with the printer.

° Printer status report

° Network configuration page

° Printer information page

° Print quality diagnostic report

° Wireless test report

Printer status report

Use the printer status report to view current printer information and ink cartridge status. Also use the
printer status report to help you troubleshoot problems with the printer.

The printer status report also contains a log of recent events.

If you need to call HP, it is often useful to print the printer status report before calling.
To print the printer status report

®  Press and hold the x (Cancel) button for three seconds.
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1. Product Information: Shows printer information (such as the printer name, model number, serial
number, and firmware version number), and the accessories that are installed (such as the
automatic two-sided printing accessory or duplexer).

2. Print Usage Information: Shows summary information about pages printed from the printer.

3. Ink Delivery System Information: Shows the estimated ink levels (represented in graphical form
as gauges) and the part numbers and warranty expiration dates for the ink cartridges.

E’%NOTE: Ink level warnings and indicators provide estimates for planning purposes only. When
you receive a low-ink warning message, consider having a replacement cartridge available to
avoid possible printing delays. You do not need to replace cartridges until the print quality
becomes unacceptable.

4. Additional Assistance: Provides information about where you can go to get more information
about the printer.

Network configuration page

If the printer is connected to a network, you can print a network configuration page to view the
network settings for the printer and a list of networks detected by your printer. You can use the
network configuration page to help troubleshoot network connectivity problems. If you need to call
HP, it is often useful to print this page before calling.

To print the network configuration page and wireless network test report

A Ppress the ({'}) (Wireless) button and the ® (Information) button together to print the network
configuration page and the wireless network test report.
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1.  General Information: Shows information about the current status and active connection type of
the network, and other information, such as the URL of the embedded web server.

2. 802.3 Wired: Shows information about the active Ethernet network connection, such as the IP
address, subnet mask, default gateway, as well as the hardware address of the printer.

3. 802.11 Wireless: Shows information about your wireless network connection, such as the host
name, IP address, subnet mask, default gateway, and server. It also indicates the network name
(SSID), the relative signal strengths and the channels being used.

4. HP Wireless Direct: Shows information about your HP wireless direct connection, such as the
status and hardware address.

5. Miscellaneous: Shows information about more advanced network settings.

e  Port 9100: The printer supports raw IP printing through TCP Port 9100. This HP-proprietary
TCP/IP port on the printer is the default port for printing. It is accessed by HP software (for
example, the HP Standard Port).

e  Bonjour: Bonjour services (which use mDNS, or Multicast Domain Name System) are
typically used on small networks for IP address and name resolution (through UDP port
5353), where a conventional DNS server is not used.

e  SLP: Service Location Protocol (SLP) is an Internet standard network protocol that provides
a framework to allow networking applications to discover the existence, location, and
configuration of networked services in enterprise networks. This protocol simplifies
discovery and use of network resources such as printers, web servers, fax machines, video
cameras, files systems, backup devices (tape drives), databases, directories, mail servers,
calendars.

e  Microsoft Web Services: Enable or disable the Microsoft Web Services Dynamic Discovery
(WS Discovery) protocols or Microsoft Web Services for Devices (WSD) Print services
supported on the printer. Disable unused print services to prevent access through those
services.

E/?NOTE: For more information about WS Discovery and WSD Print, visit
www.microsoft.com.

e |PP: Internet Printing Protocol (IPP) is a standard network protocol for remote printing.
Unlike other remote IP-based protocols, IPP supports access control, authentication, and
encryption, allowing for more secure printing.

e  Proxy Settings: Shows information about proxy address, port, and the status of
authentication. You can change the proxy settings from EWS.

To change the proxy settings, click Network from EWS, click Proxy Settings, and select the
appropriate options.

Printer information page

You can print a printer information page to view general status of the network connection, Web
Services (HP ePrint), and HP wireless direct.

To print the printer information page

A pressthe @ (Information) button to print the information page.
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Print quality diagnostic report

Print quality problems can have many causes-software settings, a poor image file, or the printing
system itself. If you are unhappy with the quality of your prints, a Print Quality Diagnostic page can
help you determine if the printing system is working correctly.

To print a print quality diagnostic report using the EWS
1.  Open the embedded web server (EWS). For information, see Open the embedded web server.
2. Click the Tools tab.
3.  Click Print Quality Toolbox under Utilities.
4. Click the Print Quality Report button.

To print a print quality diagnostic report using HP Utility (OS X)
1. In the Information And Support section, click Print Quality Diagnostics.
2. Click Print.
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If defects are seen on the page, follow the steps below:

1. If the Print Quality report shows faded, partial, streaked, or missing color bars or patterns, check
for depleted ink cartridges, and replace the ink cartridge that corresponds to the defective color
bar or color pattern. If there is no depleted ink cartridge, remove and reinstall all ink cartridges to
make sure they are properly installed.

Do not remove the depleted cartridge until you have a new ink cartridge available to replace. For
information about how to install new cartridges, see Replace the ink cartridges.

2. Ifthelines in Test Pattern 1 are not straight and connected, align the printer. For more
information, see Maintain the printhead and ink cartridges.

3. If you see white lines across any of the color blocks in Test Pattern 2, clean the printhead. For
more information, see Maintain the printhead and ink cartridges.
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4. If you see white or dark lines where the arrows are pointing in Test Pattern 3, align the
printhead. For more information, see Maintain the printhead and ink cartridges.

5. If none of the previous steps have helped, contact HP support to replace the printhead. For more
information, see HP support.

Wireless test report

Print the wireless test report for information about the printer wireless connection. The wireless test
report provides information about the printer status, hardware (MAC) address, and IP address. If the
printer is connected to a network, the test report displays details about the network settings.

To print the wireless network test report

A pressthe ({'}) (Wireless) button and the ® (Information) button together to print the network
configuration page and the wireless network test report.

Solve printer problems

:{7'_ TIP: (Windows) Run the HP Print and Scan Doctor to diagnose and automatically fix printing,
"*" scanning, and copying issues. The application is only available in some languages.

The printer shuts down unexpectedly
e  Check the power and power connections.

e  Make sure the printer's power cord is connected firmly to a functioning power outlet.

Printhead alignment fails

e If the alignment process fails, make sure you have loaded unused, plain white paper into the
input tray. If you have colored paper loaded in the input tray when you align the ink cartridges,
the alignment fails.

e If the alignment process fails repeatedly, you may need to clean the printhead, or you might
have a defective sensor. To clean the printhead, see Maintain the printhead and ink cartridges.

e If cleaning the printhead does not solve the problem, contact HP support. Go to www.hp.com/
support. This website provides information and utilities that can help you correct many common
printer problems. If prompted, select your country/region, and then click All HP Contacts for
information on calling for technical support.

Paper-feed problems
e  Paper is not picked up from a tray

0 Make sure paper is loaded in the tray. For more information, see Load paper. Fan the
paper before loading.

0 Make sure the paper-width guides are set to the correct markings in the tray for the paper
size you are loading. Also make sure the paper guides are snug, but not tight, against the
stack.

ENWW Solve printer problems 65


http://h20180.www2.hp.com/apps/Nav?h_pagetype=s-924&h_client=s-h-e004-01&h_keyword=lp70044-win&h_lang=en&h_cc=us
http://h20180.www2.hp.com/apps/Nav?h_pagetype=s-001&h_page=hpcom&h_client=s-h-e008-1&h_product=5390311,5390317&h_lang=en&h_cc=us
http://h20180.www2.hp.com/apps/Nav?h_pagetype=s-001&h_page=hpcom&h_client=s-h-e008-1&h_product=5390311,5390317&h_lang=en&h_cc=us

o Make sure paper in the tray is not curled. Uncurl paper by bending it in the opposite
direction of the curl.

° Make sure the stack of paper is aligned with the appropriate paper size lines on the bottom
of the input tray, and does not exceed the stack height marking on the side of the tray.

Pages are skewing

o Make sure the paper loaded in the input tray is aligned to the paper-width guides. If
needed, pull out the input tray from the printer and reload the paper correctly, making sure
that the paper guides are aligned correctly.

o Load paper into the printer only when it is not printing.
Multiple pages are being picked up

o Make sure the paper-width guides are set to the correct markings in the tray for the paper
size you are loading. Also make sure the paper-width guides are snug, but not tight, against
the stack.

o Make sure the tray is not overloaded with paper.

0 Use HP paper for optimum performance and efficiency.

Solve printing problems

:@: TIP: (Windows) Run the HP Print and Scan Doctor to diagnose and automatically fix printing,
“*" scanning, and copying issues. The application is only available in some languages.

The printer is not responding (nothing prints)

66 Chapter 8

There are print jobs stuck in the print queue

Open the print queue, cancel all documents, and then reboot the computer. Try to print after the
computer reboots. Refer to the Help system for the operating system for more information.

Check the HP software installation

If the printer is turned off when printing, an alert message should appear on your computer
screen; otherwise, the HP software provided with the printer might not be installed correctly. To
resolve this, uninstall the HP software completely, and then reinstall the HP software.

Check the cable connections

Make sure both ends of the USB cable or Ethernet cable are secure.
If the printer is connected to a network, check the following:

o Check the Link light on the back of the printer.

° Make sure you are not using a phone cord to connect the printer.
Check any personal firewall software installed on the computer

The personal software firewall is a security program that protects a computer from intrusion.
However, the firewall might block communication between the computer and the printer. If there
is a problem communicating with the printer, try temporarily disabling the firewall. If the problem
persists, the firewall is not the source of the communication problem. Re-enable the firewall.
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@ Use this troubleshooter to help you get your printer on the network if you have a firewall

or antivirus protection that is causing a problem. Click here to go online for more information. At
this time, this website might not be available in all languages.

Restart the printer and the computer

If the printer is still not responding, turn off the printer and the computer, and turn them back on.

@ If the above solutions do not resolve the problem, click here for more online troubleshooting.

Something on the page is missing or incorrect

Try the solutions in Print quality is not acceptable
Check the printer location and length of USB cable

High electromagnetic fields (such as those generated by USB cables) can sometimes cause
slight distortions to printouts. Move the printer away from the source of the electromagnetic
fields. Also, it is recommended that you use a USB cable that is less than 3 meters (9.8 feet)
long to minimize the effects of these electromagnetic fields.

Print quality is not acceptable

ENWW

1.

Make sure you are using genuine HP ink cartridges. Genuine HP ink cartridges are designed
and tested with HP printers to help you easily produce great results, time after time.

E/?’NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Printer service or

repairs required as a result of using a non-HP supply are not covered under warranty.
If you believe you purchased genuine HP ink cartridges, go to:

www.hp.com/go/anticounterfeit

Check the ink levels. The ink cartridges might have insufficient ink.

2»NOTE: Ink level alerts and indicators provide estimates for planning purposes only. When you

receive a low-ink alert, consider having a replacement cartridge available to avoid possible
printing delays. You do not need to replace the ink cartridges until the print quality becomes
unacceptable.

/\ CAUTION: While ink cartridges are not damaged when left outside of the printer, the printhead

does need to have all cartridges installed at all times after the printer is set up and in use.
Leaving one or more cartridge slots empty for an extended period may lead to print quality
problems and possibly damage the printhead. If you have recently left a cartridge out of the
printer for an extended period, or if you have had a recent paper jam, and have noticed poor
print quality, clean the printhead. For more information, see Maintain the printhead and ink

cartridges.

For more information, see Check the estimated ink levels.

Check the paper loaded in the input tray. Make sure the paper is loaded correctly and that it is
not wrinkled or too thick.

Solve printing problems
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e Load paper with the print side facing down. For example, if you are loading glossy photo
paper, load the paper with the glossy side down.

e  Make sure the paper lays flat in the input tray and is not wrinkled. If the paper is too close to
the printhead during printing, the ink might be smeared. This can happen if the paper is
raised, wrinkled, or very thick, such as a mailing envelope.

For more information, see Load paper.
4. Check the paper type.

HP recommends that you use HP papers or any other paper type with ColorLok technology that
is appropriate for the printer. All papers with the ColorLok logo are independently tested to meet
high standards of reliability and print quality, and produce documents with crisp, vivid color,

bolder blacks and dry faster than ordinary plain papers. For more information, see Paper basics.

Always make sure the paper you are printing on is flat. For best results when printing images,
use HP Advanced Photo Paper.

Store specialty paper in its original packaging inside a resealable plastic bag on a flat surface in
a cool, dry place. When you are ready to print, remove only the paper you plan to use
immediately. When you have finished printing, return any unused photo paper to the plastic bag.
This prevents the photo paper from curling.

5. Check the print settings by clicking the button that opens the Properties dialog box. (Depending
on your software application, this button might be called Properties, Options, Printer Setup,
Printer Properties, Printer, or Preferences.)

e  Check the print settings to see if the color settings are incorrect.

For example, check to see if the document is set to print in grayscale. Or, check to see if
advanced color settings such as saturation, brightness, or color tone, are set to modify the
appearance of colors.

e  Check the print quality setting and make sure it matches the type of paper loaded in the
printer.

You might need to choose a lower print quality setting if colors are running into each other.
Or, choose a higher setting if you are printing a high-quality photo, and then make sure
photo paper such as HP Advanced Photo Paper is loaded in the input tray.

=7 NOTE: On some computer screens, colors might appear differently than they do when printed
on paper. In this case, there is nothing wrong with the printer, print settings, or ink cartridges. No
further troubleshooting is required.

6. Print and evaluate a print quality report. To print this report, see Print quality diagnostic report.

@ Use this document to help resolve print quality issues. Click here to go online for more

information. At this time, this website might not be available in all languages.

Solve problems using HP ePrint

If you are having problems using HP ePrint, check the following:

e  Make sure the printer is connected to the Internet using an Ethernet or wireless connection.
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E/?’NOTE: You cannot use these web features if the printer is connected using a USB cable.

e  Make sure the latest printer updates have been installed on the printer. For more information,
see Update the printer.

e  Make sure HP ePrint is enabled on the embedded web server (EWS). For more information, see
Set up HP ePrint.

e  Make sure the network hub, switch, or router is turned on and working correctly.

e If you are connecting the printer using an Ethernet cable, make sure you are not connecting the

printer using a phone cord or a crossover cable to connect the printer to the network and that the

Ethernet cable is securely connected to the printer. For more information, see General network
troubleshooting.

e If you are connecting the printer using a wireless connection, make sure the wireless network is
functioning properly. For more information, see Unable to connect the printer wirelessly.

e If you are using HP ePrint, check the following:
0 Make sure the printer's email address is correct.

° Make sure that the printer's email address is the only address listed in the “To” line of the
email message. If other email addresses are listed in the “To” line, the attachments you are
sending might not print.

° Make sure you are sending documents that meet the HP ePrint requirements. For more
information, visit HP Connected at www.hpconnected.com.

e If your network uses proxy settings when connecting to the Internet, make sure the proxy
settings you are entering are valid:

° Check the settings being used by the Web browser you are using (such as Internet
Explorer, Firefox, or Safari).

0 Check with the IT administrator or person who set up your firewall.

If the proxy settings used by your firewall have changed, you must update these settings in
either the printer control panel. If these settings are not updated, you will not be able to use
HP ePrint.

For more information, see Set up HP ePrint.

_‘{?'_ TIP: For additional help on setting up and using Web Services, visit HP Connected at
“** www.hpconnected.com.

Solve network problems
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This section provides solutions to common problems on connecting or using the printer on the
network.

e General network troubleshooting

° Unable to connect the printer wirelessly

Solve network problems
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For more information about network problems, check the following:

Use this troubleshooter to help find your network security settings. Click here to go online for
more information. At this time, this website might not be available in all languages.

Use this troubleshooter that helps you to convert a USB connection to a wireless one. Click here
to go online for more information. At this time, this website might not be available in all
languages.

Use this troubleshooter to help you connect to HP wireless direct, or to help you troubleshoot HP
wireless direct issues, such as not being able to connect to HP wireless direct, not being able to
print when using HP wireless direct, or you cannot connect to the Internet. Click here to go
online for more information. At this time, this website might not be available in all languages.

Use this troubleshooter to help you get your printer onto your network, or it was on your network
and now it is not. Click here to go online for more information. At this time, this website might not
be available in all languages.

Use this troubleshooter to help you get your printer on the network if you have a firewall or
antivirus protection that is causing a problem. Click here to go online for more information. At
this time, this website might not be available in all languages.

General network troubleshooting

During software installation if the software canot find the printer on the network you will be prompted
to enter the printer's IP address which is found on the network configuration page. For more
information, see Network configuration page.

- TIP:  You can visit the HP online support website at www.hp.com/support for information and utilities
"= that can help you correct many common printer problems.

(Windows) Run the HP Print and Scan Doctor to diagnose and automatically fix printing, scanning,
and copying issues. The application is only available in some languages.

Ensure the following:

If making a wired connection to a network, connect the Ethernet cable when prompted during
software installation and check that the Ethernet light near the connector turns on.

All cable connections to the computer and the printer are secure.
The network is operational and the network hub, switch, or router is turned on.

(Windows) All applications, including virus protection programs, spyware protection programs,
and firewalls, are closed or disabled during software installation.

Unable to connect the printer wirelessly
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Make sure you have already set up the printer wireless capabilities. For more information, see Set up
the printer for wireless communication.

@*NOTE: Make sure that an Ethernet cable is not connected to the printer. Connecting an Ethernet
cable turns off the printer wireless capability.

Try the following steps to connect the printer wirelessly.

1.

Chapter 8 Solve a problem

Make sure the Wireless (802.11) light is turned on. If the blue wireless light on the printer control
panel is not lit, the wireless capability of the printer might be turned off.

To turn on the wireless capability of the printer
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Press the ({'}) (Wireless) button to turn on the printer wireless capabilities.

If the blue wireless light is blinking, it means the printer is not connected to a network. For more
information, see Set up the printer on your wireless network.

2. Make sure the computer is connected to the wireless network

If you cannot connect the computer to the network, there might be a hardware issue with the
router or computer.

3. Verify that the printer's IP address has not been altered. If the printer's IP address has changed
since it was first installed, you need to run the Update IP utility to print again. The Update IP
address utility was installed by the software.

a. Open the printer software. For more information, see Open the HP printer software

(Windows).
b. Select the Update IP address utility.

If the test fails, review the test report for information on how to fix the problem and run the test
again.

4. Run the wireless test to make sure the wireless connection is working properly.
a. Make sure the printer is turned on and paper is loaded in the tray.
b.  Onthe printer control panel, press the ({'}) (Wireless) button and the ® (Information)
button together to print the network configuration page and the wireless network test report.

If the test fails, review the test report for information on how to fix the problem and run the test
again.

5. Restart components of the wireless network.
a. Turn off the router and the printer.
b. Turn the router and the printer back on in this order: router first and then printer.

Sometimes, turning off devices and then turning them back on helps resolve network
communication issues. If you still cannot connect, turn off the router, the printer, and the
computer, and then turn them back on in this order: router first, then printer, and then computer.

@ Use this troubleshooter to help you get your printer onto your network, or it was on your

network and now it is not. Click here to go online for more information. At this time, this website might
not be available in all languages.

If you still have problems, visit the HP Wireless Printing Center (www.hp.com/go/wirelessprinting). (At
this time, this website might not be available in all languages.) The website contains the latest
information about setting up and using the printer on a wireless network, and resolving issues on
wireless connection and security software.

If the wireless connection cannot be made, the printer can also be connected to the network using an
Ethernet cable.

Maintain the printer
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This section provides instructions for keeping the printer in top working condition. Perform these
maintenance procedures as necessary.

Maintain the printer
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Clean the exterior

Maintain the printhead and ink cartridges

Clean the exterior

AWARNING! Before cleaning the printer, turn the printer off by pressing (!y (the Power button) and
unplug the power cord from the electrical socket.

Use a soft, damp, lint-free cloth to wipe dust, smudges, and stains off of the case. Keep fluids away
from the interior of the printer, as well as from the printer control panel.

Maintain the printhead and ink cartridges

If you are experiencing problems with printing, you might have a problem with the printhead. You
should perform the procedures in the following sections only when directed to do so for resolving print
quality issues.

Performing the aligning and cleaning procedures unnecessarily can waste ink and shorten the life of
the cartridges.

Clean the printhead if your printed output is streaked or has any incorrect or missing colors.

There are three stages of cleaning. Each stage lasts about two minutes, uses one sheet of
paper, and uses an increasing amount of ink. After each stage, review the quality of the printed
page. You should only initiate the next phase of cleaning if the print quality is poor.

If print quality still seems poor after you complete all stages of cleaning, try aligning the printer. If
print quality problems persist after cleaning and aligning, contact HP support. For more
information, see HP support.

If print quality still seems poor after you complete both stages of cleaning, try aligning the printer.
If print quality problems persist after cleaning and aligning, contact HP support. For more
information, see HP support.

The printer automatically aligns the printhead during the initial setup.

You might want to use this feature when the printer status page shows streaking or white lines
through any of the blocks of color or if you are having print quality issues with your printouts.

Clean page smears when your printed output has smearing on the back. Ink may have built up in
some areas of the printer and needs to be removed.

@NOTE: Cleaning uses ink, so clean the printhead only when necessary. The cleaning process takes
a few minutes. Some noise might be generated in the process.

Turning the printer off improperly can cause print quality problems. For more information, see Turn
the printer off.

To clean or align the printheads, or clean page smears, from the Toolbox (Windows)

1.
2.
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Open Toolbox. For more information, see Toolbox (Windows).

From the Device Services tab, click the desired option, and then follow the on-screen
instructions.
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To clean or align the printheads, or clean page smears, from the embedded web server (EWS)

1. Open the the embedded web server (EWS). For more information, see Open the embedded web
server.

2. Click the Tools tab, and then click Print Quality Toolbox in the Utilities section.

3. Click the desired option, and then follow the on-screen instructions.

To clean or align the printheads, or clean page smears, from HP Utility (OS X)

1.  Open HP Utility. For more information, see HP Utility (OS X).

2. Inthe Information And Support section, click the desired option, and then follow the on-screen
instructions.

Clear paper jams

Occasionally, paper becomes jammed during a job.

/\ CAUTION: To prevent possible damage to the printhead, clear paper jams as soon as possible.

To clear a paper jam

/\ CAUTION: Do not pull jammed paper from the front of the printer, instead follow the steps below to
clear the jam. Pulling out jammed paper from the front of the printer might cause the paper to tear and
leave torn pieces inside the printer; this could result in more jams later.

1. Open the ink cartridge access door.

2. Check the paper path inside the printer.

a. Lift the handle of the paper path cover and remove the cover.
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b. Locate any jammed paper inside the printer, grasp it with both hands and pull it towards
you.

ACAUTION: If the paper tears when you are removing it from the rollers, check the rollers
and wheels for torn pieces of paper that might be remaining inside the printer.

If you do not remove all the pieces of paper from the printer, more paper jams are likely to
occur.
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c. Reinsert the paper path cover until it snaps into place.

3. If the problem is not resolved, check the print carriage area inside the printer.

ACAUTION: During the process, avoid touching the cable attached to the print carriage.

a. Ifthere is any jammed paper, move the print carriage to the far right of the printer, grasp the
jammed paper with both hands, and then pull it towards you.

/\ CAUTION: If the paper tears when you are removing it from the rollers, check the rollers
and wheels for torn pieces of paper that might be remaining inside the printer.

If you do not remove all the pieces of paper from the printer, more paper jams are likely to
occur.
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b. Move the carriage to the far left of the printer, and do the same as in the previous step to
remove any torn pieces of paper.

4. Close the ink cartridge access door.
5. Ifthe problem is still not resolved, check the tray area.

a. Lift the output tray.

b. Pull out the input tray to extend it.

E/%"NOTE: Upon opening the input tray, you will be prompted to retain or change the paper
size setting. If you have loaded a different sized paper, change the paper size. For more
information, see Set the paper size for the printer.
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c. Press down the buttons on both sides of the input tray, and pull to remove the input tray.

d. Check the gap in the printer where the input tray was. If there is any jammed paper, reach
into the gap, grasp the paper with both hands and pull it towards you.

/\ CAUTION: If the paper tears when you are removing it from the rollers, check the rollers
and wheels for torn pieces of paper that might be remaining inside the printer.

If you do not remove all of the pieces of paper from the printer, more paper jams are likely
to occur.

@ Click here to use the HP online troubleshooter to resolve a paper jam.
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@ If the print carriage cannot move, click here to use the HP online troubleshooter to resolve a
print carriage jam. At this time, this website might not be available in all languages.

To avoid paper jams
To help avoid paper jams, follow these guidelines.
e Remove printed papers from the output tray frequently.
e Make sure that you are printing with paper that is not wrinkled, folded, or damaged.
e Prevent curled or wrinkled paper by storing all unused paper flat in a resealable bag.
e Do not use paper that is too thick or too thin for the printer.

e  Make sure that the trays are loaded correctly and are not too full. For more information, see
Load paper.

e  Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.

e Do not combine different paper types and paper sizes in the input tray; the entire stack of paper
in the input tray must be the same size and type.

e Adjust the paper-width guides in the input tray to fit snugly against all paper. Make sure the
paper-width guides do not bend the paper in the input tray.

e Do not force paper too deep inside the input tray.

e If you are printing on both sides of a page, do not print highly saturated images on light weight
paper.

e Use paper types that are recommended for the printer. For more information, see
Recommended papers for printing.

e If the printer is about to run out of paper, allow the printer to run out of paper first, and then add
paper. Do not load paper when the printer printing.

e Make sure that the printer is clean. For more information, see Maintain the printer.

Reset the printer
You can restore the printer to the original network settings.
To restore the printer to the original network settings

A On the printer control panel, press and hold the ({'}) (Wireless) button and the 3¢ (Cancel)
button together, approximately five seconds, and then release the buttons.
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A Technical information

This section contains the following topics:

e  Specifications

° Regqulatory information

° Environmental product stewardship program

Specifications

System requirements

e  Software and system requirements can be found in the Readme file, which is available on the

HP printer software CD provided with your printer.

e  Forinformation about future operating system releases and support, visit the HP online support

website at www.hp.com/support.

Environmental specifications

e  Operating temperature: 5° to 40° C (41° to 104° F)

e  Operating humidity: 15 to 80% RH non-condensing

e Recommended operating conditions: 15° to 32° C (59° to 90° F)

e Recommended relative humidity: 20 to 80% noncondensing
Input tray capacity

e  Plain paper sheets (60 to 105 g/m? [16 to 28 Ib]): Up to 225

e Envelopes: Up to 30

e Index cards: Up to 80

e  Photo paper sheets: Up to 100

Output tray capacity
e  Plain paper sheets (60 to 105 g/m? [16 to 28 Ib]): Up to 60

Paper size and weights
For the list of supported paper sizes, see the HP printer software.
e  Plain paper: 60 to 105 g/m? (16 to 28 Ib)
e  Envelopes: 75 to 90 g/m? (20 to 24 Ib)
e  Cards: Up to 200 g/m? (110-lb index maximum)
e  Photo paper: 250 g/m? (66 Ib)

ENWW
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Print specifications
e  Print speeds vary according to the complexity of the document and printer model
e  Method: drop-on-demand thermal officejet
e Language: PCL3 GUI

° Print resolution:

Draft mode e  Color Input/Black Render: 300x300dpi

e  Output (Black/Color): Automatic

Normal mode e  Color Input/Black Render: 600x600dpi

e  Output (Black/Color): Automatic

Plain-Best mode e  Color Input/Black Render: 600x600dpi

e  Output (Black/Color): Automatic

Photo-Best mode e  Color Input/Black Render: 600x600dpi

e  Output (Black/Color): Automatic

Max DPI mode e  Color Input/Black Render: 1200x1200dpi

e  Output: Automatic (Black/Color), 4800x1200 optimized dpi (Photo Paper,
Color)

To print in maximum dpi mode, see Print using the maximum dpi.

Cartridge yield

e Visit www.hp.com/go/learnaboutsupplies for more information on estimated cartridge yields.

Acoustic emission specifications
e Sound pressure (bystander position)
° LpAm 57 (dBA) (mono Draft print)
e  Sound power
o LwAd 7.0 (BA)

For more information, visit www.hp.com/support. Select your country or region. Click Product Support
& Troubleshooting. Enter the name shown on the front of the printer, and then select Search. Click
Product information, and then click Product specifications.

Regulatory information

The printer meets product requirements from regulatory agencies in your country/region.
This section contains the following topics:

° Regulatory Model Number

° FCC statement

° Notice to users in Korea

e VCCI (Class B) compliance statement for users in Japan
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Notice to users in Japan about the power cord

Noise emission statement for Germany

Visual display workplaces statement for Germany

European Union Regulatory Notice

Declaration of conformity

Regulatory information for wireless products

Regulatory Model Number

For regulatory identification purposes, your product is assigned a Regulatory Model Number. The
Regulatory Model Number for your product is SNPRC-1403-01. This regulatory number should not be
confused with the marketing name (HP Officejet Pro 6230 ePrinter) or product number (E3EQ3A).

FCC statement

FCC statement

The United States Federal Communications Commission (in 47 CFR 15.105) has specified
that the following nofice ba brought to the attention of usars of this product.

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed fo provide reason-
able profechion against harmful inferference in o residential installafion. This equipment
generates, uses and can rodiate radic frequency energy and, if not installed and used in
accordance with the instruchions, may couse harmful interference to radic communicafions.
However, there is no guarantee that interference will not occur in a particular installation.
If this equipment does cause harmful interferance to radio or television reception, which can
be determined by tuming the equipment off and on, the user is encouraged to iry fo comect
the interference by one or more of the following measures:

Recrient or rebocate the receiving antenna.

Increase the separation behween the equipment and the recaiver.

Caonnect the equipment info an oullst on o circuit different from that to which the

receiver is conn

Consult the dealer or an experienced radic/TV technician for halp.

For further information, contoct:

Manager of Corporate Product Regulations

Hewlett-Packord Company

3000 Hamower Strest

Palo Allo, Co 74304

[&650) 8571501
Medifications (part 15.21)
The FCC requires the vser fo be notified that any changes or medifications mode to this
devica that are not expressly approved by HP may void the user's authority to operate the
equipment.
This device complies with Part 15 of the FCC Rules. Operoficn is subject fo the fellowing
two conditions: (1) this device may not couse harmful interference, and (2] this device must
accept any interference recenved, incduding interference that may couse undesired
operation.

Notice to users in Korea
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VCCI (Class B) compliance statement for users in Japan

CindRER. FSABEEREEEETT. CESE.
FERETHERT 2 L #EIE LTHETH, CoEED
SAeTLES 3 FEOAE L TERIHS . =
EEEFs|SROT CEMNENET, INEEREEE(CE T
LA MR E LT TSy,

VCCI-B

Notice to users in Japan about the power cord

ERCR, FEzh LRI -—FESEVTEL,
E#zhfFEI—kE, toMRTEERALREEA.

Noise emission statement for Germany

Gertuschemission
LpA < 70 dB am Arbeitsplatz im Normalbetrieb nach DIN 45635 T. 19

Visual display workplaces statement for Germany

G5-Erkltrung (Dovtschland)

Dras (et ist nicht for die Bemvtzeng im ermittelboren Gesichiskdd om Bildschimmarbeisphatz
vorgasahen, Um Sorende Reflexionen am Bildschirmarbaitsplofz v vermeiden, darf dieses Produld
richt im unmitalboran Gesichistold platziert wardan.

European Union Regulatory Notice

C€

Products bearing the CE marking comply with one or more of the following EU Directives as may be
applicable: Low Voltage Directive 2006/95/EC, EMC Directive 2004/108/EC, Ecodesign Directive
2009/125/EC, R&TTE Directive 1999/5/EC, RoHS Directive 2011/65/EU. Compliance with these
directives is assessed using applicable European Harmonised Standards. The full Declaration of
Conformity can be found at the following website: www.hp.com/go/certificates (Search with the
product model name or its Regulatory Model Number (RMN), which may be found on the regulatory
label.)

The point of contact for regulatory matters is:
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Hewlett-Packard GmbH, Dept./MS: HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen,
GERMANY

Products with external AC Adapters

CE compliance of this product is valid only if powered with the correct CE-marked AC adapter
provided by HP.

Products with wireless functionality

EMF

e This product meets international guidelines (ICNIRP) for exposure to radio frequency radiation.

If it incorporates a radio transmitting and receiving device then in normal use, a separation
distance of 20 cm ensures that radio frequency exposure levels comply with EU requirements.

Wireless functionality in Europe

e  This product is designed for use without restrictions in all EU countries plus Iceland,
Liechtenstein, Norway and Switzerland.

European telephone network declaration (Modem/Fax)

HP products with FAX capability comply with the requirements of the R&TTE Directive 1999/5/EC
(Annex Il) and carry the CE marking accordingly. However, due to differences between the individual
PSTNs provided in different countries/regions, the approval does not, of itself, give an unconditional
assurance of successful operation on every PSTN network termination point. In the event of
problems, you should contact your equipment supplier in the first instance.

ENWW Regulatory information
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Declaration of conformity

I DECLARATION OF CONFORMITY
according to ESONEC 170501 and EN 170501

Dol ¥y SMPRCS1 40300 -4

Supplier's Nama: Howleti-Pockard Company
Supplier's Address: 138 Depot Rood, #0401, Singopore 109683
detlares, that the praduc

Product Mams and Model: HF Ot Fro 6230 efrinter, HF Officojet 6720 ePrinter
Regulatery Model Mumbaer: 1 SHERC. 140300

Prodwct Options all
Powar Adapter: Interad, ANTE0S0008 & ASTBOS0007 [See 3 under Additional Inkermation|
Radia Madisle Mumber: EDGOR 1 TVE [See 4 wnker Adddificnanl Il

EMAC: CISFR 230008 / ENGS0TE N0 Can B
EM S5024: 2000
ERd & 1000 32 000 w8 200 w2 00
ER &1 00K 3-3: e
FOC CFR 47, Fost 15 KES003, bsee 5

Safety:  IEC &0950-1:2005 (2nd Edion}ed 1: 2009/ EM G050 1: 2008+A | 1: 300941 2010+:A12-2011
Erd & 24702000

Tebecomr  EH 307 4881 V1.0 R2001 /B 300 48207 VR 12009
ER 300 3T VIR 2004
ERd 6230 1: 2008

Emergy:  Eegulofion [EC) Mo 1375, 0006
EMERGY STARE Cuakfied mogng Equipment OpemBonsal Mode (O8] Tt Frecedurs
Regulation [EC] Mo, 278/ 2009

Test Metad lor Colosating the Enengy EHichency of Single-Vologe Extemnal Ac-Dc ond Ac-Ac Power Supplees (August 11,
2004

RoH:
B SO0 3

Thes. dhrvioe compdees with part 15 of the FOC Bubes. Operotce is subjec! o e lollewving b condilion:
(1] Thss dhireici iwory sk ety bkl indarbavance, and |0 i divic il Gooegl ey inbiderencs reoened, inchading interlevencs thal
ey o encesned open hion

Thir prosduct havewith complion with tha noquisesant of the Low Vologe Direcee D006 50, the EMC Dinectve 2004/ 108/EC, the
RATTE Disecires 1599/5/EC, the Ecodesign Direcive 2009/ 1 25/EC, the RolS Deeeciiee 201 1,/95,/EU and camies ihe CE marking
Additienal Infarmatien:

1] Tha product is assigeed o Regulaionry Model MHember whch shoys with the reguliory capect. of the design. The Regulstory Model
Musbsr i B mae peoduct idessilier in the rguloleny docums niaton and ke sepons, This sumsbsr should not be conleed with the
menkating noma or e produt romben

Z The produc woe kested inoo Fepood « N,

3 The irberresl v ockapler ADTELA0000 b b Inda and Ching makel onlp,

4] 'WIF module opemies caly in 3,40 bond within thin product,

Singoporne
22 Hovesber 2013

Letal contact for regulatory topics only:
EMEA:  Hewles Pockord Gmbl, HGMTRE, Hemenberger Srosse 140, 71034 Boeblisgen, Cesmany
s Fhawdet Pockord, 000 Honower 5, Polo Ala $4304, U5 A 6508570501

wrerw b s e
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Regulatory information for wireless products

This section contains the following regulatory information pertaining to wireless products:

° Exposure to radio frequency radiation

° Notice to users in Brazil

° Notice to users in Canada

° Notice to users in Taiwan

° Notice to users in Mexico

° Wireless notice to users in Japan

Exposure to radio frequency radiation

Exposure to radio frequency radiation

Caution The radiated output r of this device is far below the FCC radic

& frequency exposure limits. Meve , the device shall be vsad in such a manner
that the potenfial for human contoct during nermal operation is minimized. This
preduct and any attached external antenna, if supported, shall be placed in such
a manner fo minimize the potential for human contoct during nermal operation. In
order to avoid the possibility of exceeding the FCC rodio frequency exposure
limits, hurman proximity to the antenna shall not be less than 20 om (8 nches)
during nomal operation.

Notice to users in Brazil

Aviso aos usudrios no Brasil

Este equipamento opera em carater secunddrio, isfo &, ndo fem direite & protecio conira
interferéncia prejudicial, mesmo de estacdes do mesme tipo, e ndo pode causar inferferén-
cia a sistemas operando em cardter primarnio.
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Notice to users in Canada

MNotice to users in Canada/Note a l'attention des utilisateurs canadiens

Under Industry Canada regulations, this radie transmitter may only operale using an
anlenna of a type and maximum (or lesser) gain opproved for the transmilter by Industry
Caonada. Te reduce pobential radio interference o other users, the anfenna type and its gain
should be so chosen that the equivalent isotropically radiated power [e.i.rp.) is not more
than that necessary for successful communication.

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is
subject to fhe following fwe condifions: (1) this device may not cause inlerference, and (2)
this device must accept any interference, including interference that may cause undesired
operafion of the device.

WARNING! Expesure to Radie Frequency Radistion The rodicled culput power of this
device is below the Indusiry Canada rodic frequency exposure limits. Nevertheless, the
device should be used in such a manner that the potential for human contact is minimized
during normal cperaficn.

T avoid the possibility of exceeding the Industry Canada radic frequency exposure limits,
human proximity te the anfennas should not be less than 20 cm (8 inches).

Conformément au Réglement d'lndusiie Canada, cet émetteur radicélecirique ne peut
fonctionner qu'avec une antenne d'un type et d'un gain maximem |ov moindre) approvve
par Industrie Canada. Afin de réduire le brouillage radisélectrique potentiel pour d'autres
utilisateurs, le type d'anlenne ef son gaoin doivent ére choisis de manidére & ce que la
puissance isclrope rayonnée équivalente [p.ire.) ne dépasse pos celle nécessaire @ une
communication réussie.

Cet appareil est conforme oux normes B35 exemples de licence d'Industie Conada, Son
fenctionnement dépend des deux conditions suivantes - (1) cet oppareil ne doit pas
provoquer d'interférences nuisibles et [2) doil accepler toutes inferférences reques, y
compris des inlerférences pouvant provoquer un fonctionnement non souhaité de 'appareil.
AVERTISSEMEMT relalif & I'exposition aux rodiclréquences. Lla puissance de rayonnement
de cet appareil se trouve sous les limites d'exposition de rodiclréquences d'lndustrie
Canada. Méanmains, cet appareil doit étre utilizé de telle scrie qu'il soit mis en contact e
mins possible avec be corps humain.

Afin d'éviter le dépossement éventuel des limites d'exposition aux rodicfréquences
d'Industrie Canada, il est recommandé de maintenir une distance de plus de 20 em enire
les antennes et I'utilisatewr.

Notice to users in Taiwan
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Notice to users in Mexico

Aviso para los usuarios de México

la operacion de este equipo estd sujeta o las siguientes dos condiciones: (1) es pesible
que este equipo o dispositive no cause interlerencia perjudicial v (2} este equipo o
dispositive debe aceptar cualquier interferencia, incluyende la que pueda causar su
operacion no deseada

Para saber el modele de la farjeta inaldmbrica utilizada, revise la etiqueta regulatoria de
la impresora

Wireless notice to users in Japan

COfFRFENERES AL IFEHER R - RREREEEL TVET.

Environmental product stewardship program

Hewlett-Packard is committed to providing quality products in an environmentally sustainable manner:

ENWW

Design for recycling has been incorporated into this product.

The number of materials has been kept to a minimum while ensuring proper functionality and
reliability.

Dissimilar materials have been designed to separate easily.
Fasteners and other connections are easy to locate, access, and remove using common tools.

High priority parts have been designed to access quickly for efficient disassembly and repair.

For more information, visit www.hp.com/ecosolutions

This section contains the following topics:

Paper use

Plastics

Material safety data sheets

Recycling program

HP inkjet supplies recycling program

Disposal of waste equipment by users

Power consumption

Chemical substances

Battery disposal in the Taiwan

Battery notice for Brazil

California Perchlorate Material Notice

Toxic and hazardous substance table (China)

Restriction of hazardous substance (Ukraine)

Restriction of hazardous substance (India)
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e EPEAT

° China SEPA Ecolabel User Information

Paper use
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics

Plastic parts over 25 grams are marked according to international standards that enhance the ability
to identify plastics for recycling purposes at the end of product life.

Material safety data sheets
Material safety data sheets (MSDS) can be obtained from the HP website at:

www.hp.com/go/msds

Recycling program

HP offers an increasing number of product return and recycling programs in many countries/regions,
and partners with some of the largest electronic recycling centers throughout the world. HP conserves
resources by reselling some of its most popular products. For more information regarding recycling of
HP products, please visit:

www.hp.com/recycle

HP inkjet supplies recycling program

HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is
available in many countries/regions, and lets you recycle used print cartridges and ink cartridges free
of charge. For more information, go to the following website:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Disposal of waste equipment by users

This symbol means do not dispose of your product with your other household waste.
Instead, you should protect human health and the environment by handing over your
waste equipment to a designated collection point for the recycling of waste electrical
and electronic equipment. For more information, please contact your household waste
disposal service, or go to http://www.hp.com/recycle.

Power consumption

Hewlett-Packard printing and imaging equipment marked with the ENERGY STAR® logo is qualified
to the U.S. Environmental Protection Agency’s ENERGY STAR specifications for imaging equipment.
The following mark will appear on ENERGY STAR qualified imaging products:
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ENERGY STAR
Additional ENERGY STAR qualified imaging product model information is listed at: www.hp.com/go/
energystar

Chemical substances

HP is committed to providing our customers with information about the chemical substances in our
products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this
product can be found at: www.hp.com/go/reach.

Battery disposal in the Taiwan

RA
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Battery notice for Brazil

A bateria deste equipamento n&o foi projetada para ser removida pelo cliente.

California Perchlorate Material Notice

California Perchlorate Material Notice

Perchlorate material - special handling may apply. See:
http://www.dtsc.ca.gov/hazardouswaste/perchlorate /

This product’s realtime clock battery or coin cell battery may contain perchlorate and
may require special handling when recycled or disposed of in California.
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Toxic and hazardous substance table (China)
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Restriction of hazardous substance (Ukraine)

TexHidHMIA pernameHT wWono oOMmerKeHHS BUKOPUCTAOHHA
HebeineuyHux peuoeuH (YkpaiHa)
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3aTBepmkeHoro noctaosoio Kabikery Minictpie Ykpainm sig 3 rpyaxs 2008 Ne 1057

Restriction of hazardous substance (India)

Restriction of hazardous substances (India)

This product complies with the "India E-waste (Management and Handling) Rule 201" and
prehibits use of lead, mercury, hexavolent chromivm, polybrominated bighenyls or
pelybrominated diphenyl sthers in concentrations exceading 0.1 weight % and 0.01 weight
% for cadmium, sxcept for the exemptions set in Scheduls 2 of the Ruls.

EPEAT

EPEAT

Most HP products are designed to meet EPEAT. EPEAT is a comprehensive
environmental rating that helps identify greener electronics equipment. For maore
information on EPEAT go to www.epeat.net. For information on HP's EPEAT
registered products go to
www.hp.com/hpinfo/globalcitizenshipfenvironment/pdffepeat_printers.pdf.
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China SEPA Ecolabel User Information
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B Errors (Windows)

° Low on ink

e Verylow on ink
° Ink cartridge problem

° Paper size mismatch

° Ink cartridge carriage stalled

° Paper jam or tray problem

e  Out of paper

° Document failed to print

° Printer failure

° Door open

° Ink cartridge failure

° Printer supply upgrade problem

e  Counterfeit Cartridge Advisory
e Use SETUP cartridges

e Do not use SETUP cartridges

e  Problem with SETUP cartridges

° Incompatible ink cartridges

° Problem with Printer Preparation

° Paper too short

° Ink cartridge incorrectly installed

° Problem with printhead

° HP Protected Cartridge Installed

Low on ink

The ink cartridge identified in the message is low on ink.

Ink level warnings and indicators provide estimates for planning purposes only. When you receive
a low ink warning message, consider having a replacement cartridge available to avoid possible
printing delays. You do not need to replace cartridges until the print quality becomes unacceptable.

For information about replacing ink cartridges, see Replace the ink cartridges. For information about
ordering ink cartridges, see Order ink cartridges. For information about recycling used ink supplies,
see HP inkjet supplies recycling program.
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=¥ NOTE: Ink from the cartridges is used in the printing process in a number of different ways,

including in the initialization process, which prepares the printer and cartridges for printing. In
addition, some residual ink is left in the cartridge after it is used. For more information see
www.hp.com/go/inkusage.

Very low on ink

The ink cartridge identified in the message is very low on ink.

Ink level warnings and indicators provide estimates for planning purposes only. When you receive
a very low ink warning message, HP recommends having a replacement cartridge available to avoid
possible printing delays. You do not need to replace cartridges until the print quality is unacceptable.

For information about replacing ink cartridges, see Replace the ink cartridges. For information about
ordering ink cartridges, see Order ink cartridges. For information about recycling used ink supplies,
see HP inkjet supplies recycling program.

E’/?NOTE: Ink from the cartridges is used in the printing process in a number of different ways,

including in the initialization process, which prepares the printer and cartridges for printing. In
addition, some residual ink is left in the cartridge after it is used. For more information see
www.hp.com/go/inkusage.

Ink cartridge problem

The ink cartridge identified in the message is missing, damaged, incompatible, or inserted into the
wrong slot in the printer.

E%?NOTE: If the cartridge is identified in the message as incompatible, see Order ink cartridges for

ENWW

information about obtaining cartridges for the printer.

To solve this problem, try the following solutions. Solutions are listed in order, with the most likely
solution first. If the first solution does not solve the problem, continue trying the remaining solutions
until the issue is resolved.

e  Solution 1: Turn the printer off and on.

e  Solution 2: Install the ink cartridges correctly.

Solution 1: Turn the printer off and on

Turn off the printer, and then turn it on again.

If the problem persists, try the next solution.

Solution 2: Install the ink cartridges correctly

Make sure all of the ink cartridges are properly installed:

1.  Gently pull open the ink cartridge access door.

2. Remove the ink cartridge by pushing it in to release it, and then pulling it firmly toward you.
3. Insert the cartridge into the slot. Press firmly on the cartridge to ensure proper contact.
4

Close the ink cartridge access door and check if the error message has gone away.

Very low on ink
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Paper size mismatch

The paper size or type selected in the printer driver does not match the paper loaded in the printer.
Make sure that the correct paper is loaded in the printer, and then print the document again. For more
information, see Load paper.

=¥ NOTE: If the paper loaded in the printer is the correct size, change the selected paper size in the
printer driver, and then print the document again.

Ink cartridge carriage stalled

Something is blocking the ink cartridge carriage (the part of the printer that holds the ink cartridges).
To clear the obstruction check the printer for jams.

For more information, see Clear paper jams.

Paper jam or tray problem

Paper has become jammed in the printer.
Before you try to clear the jam, check the following:

e Make sure that you have loaded paper that meets specifications and is not wrinkled, folded, or
damaged. For more information, see Specifications.

e  Make sure that the printer is clean. For more information, see Maintain the printer.

e Make sure that the trays are loaded correctly and are not too full. For more information, see
Load paper.

For instructions on clearing jams, as well as more information about how to avoid jams, see Clear
paper jams.

Out of paper
The default tray is empty.
Load more paper, and then press the D‘ﬁ (Paper Size Selection) button to set the paper size.

For more information, see Load paper.

Document failed to print

The printer could not print the document because a problem occurred in the printing system.

For information about solving printing problems, see Solve printer problems.

Printer failure

There was a problem with the printer. Usually, you can resolve such problems by completing the
following steps:

94  Appendix B Errors (Windows) ENWW



1. Press the (1) (Power) button to turn off the printer.
2. Unplug the power cord, and then plug in the power cord again.
3. Press the (I} (Power) button to turn on the printer.

If this problem persists, write down the error code provided in the message, and then contact HP
support. For more information about contacting HP support, see HP support.

Door open

Before the printer can print documents, all doors and covers must be closed.

_‘{?'_ TIP:  When completely closed, most doors and covers snap into place.

If the problem persists after you've securely closed all doors and covers, contact HP support. For
more information, see HP support.

Ink cartridge failure

The cartridges listed in the message are damaged or have failed.

See Replace the ink cartridges.

Printer supply upgrade problem

The supply upgrade was not successful. The cartridges listed in the message can still be used in this
printer. Replace the Supply Upgrade cartridge. For more information, see Replace the ink cartridges.

Counterfeit Cartridge Advisory

The installed cartridge is not a new, genuine HP cartridge. Contact the store where this cartridge was
purchased. To report suspected fraud, visit HP at www.hp.com/go/anticounterfeit. To continue using
the cartridge, click Continue.

Use SETUP cartridges

When you first setup the printer, you must install the cartridges that shipped in the box with the
printer. These cartridges are labeled SETUP, and they calibrate your printer before the first print job.
Failure to install the SETUP cartridges during the initial product setup causes an error. If you installed
a set of regular cartridges, remove them and install the SETUP cartridges to complete printer setup.
After printer setup is complete, the printer can use regular cartridges.

if you still receive error messages and the printer cannot complete ink system initialization, contact
HP support. For more information, see HP support.

Click here to go online for more information . At this time, this website might not be available in all
languages.

Do not use SETUP cartridges

SETUP cartridges cannot be used after the printer has been initialized. Remove and install non-
SETUP cartridges. For more information, see Replace the ink cartridges.
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Problem with SETUP cartridges

There is a problem with the SETUP cartridges and the printer cannot complete ink system
initialization. Please contact HP support.

Incompatible ink cartridges

The ink cartridge is not compatible with your printer.

Solution: Remove this cartridge immediately and replace with a compatible ink cartridge. For
information about how to install new cartridges, see Replace the ink cartridges.

Problem with Printer Preparation

The printer clock has failed and ink preparation may not be complete. The estimated Ink Level gauge
might be inaccurate.

Solution: Check the print quality of your print job. If it is not satisfactory, running the printhead
cleaning procedure from the toolbox might improve it.

Paper too short

The paper loaded is shorter than the minimum requirement. Paper that meets the printer
requirements must be loaded. For more information, see Specifications and Load paper.

Ink cartridge incorrectly installed

The ink cartridge indicated in the message is not installed correctly.

Make sure all of the ink cartridges are properly installed:

1. Gently pull open the ink cartridge access door.

2. Remove the ink cartridge by pushing it in to release it, and then pulling it firmly toward you.
3. Insert the cartridge into the slot. Press firmly on the cartridge to ensure proper contact.
4.

Close the ink cartridge access door and check if the error message has gone away.

Problem with printhead

There is a problem with the printhead.
Turn off the printer, and then turn it on again.

If the problem persists, contact HP support for service. For more information, see HP support.

HP Protected Cartridge Installed

The ink cartridge listed on the printer control panel can only be used in the printer that initially
protected the cartridge using the HP Cartridge Protection feature. The ink cartridge must be replaced
in this printer.

For information about how to install a new ink cartridge, see Replace the ink cartridges.
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